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Overview 

 
Cloud integrations using an XML host do not require IMM eSign Client.  

 
TotaleAtlas, TotaleAtlas RTS, TotaleAtlas XML, TeA, TeARTS, TotaleSign, and TeSign are 
generic terms for IMM eSign. TotaleAtlas Workflow is a generic term for IMM eSign plus. Except 
where noted, IMM eSign is a generic term for IMM eSign and IMM eSign plus. eAtlas is a 
generic term for eSign Lite. In this guide, text and screenshots may use any of these terms. 
This guide provides an overview of the IMM eSign procedures available to Users and Document 
Administrators (DocAdmins). Images in this guide are from Windows 10 with Internet 
Explorer 11 except where noted. Your screens may differ with a different OS or browser. 

 

The IMM eSign menu options, pages, and features displayed on the pages vary 
depending on your integration. All menu options, pages, and features in this guide 
may not be applicable to your installation. The screenshots in this guide are examples.  

 

 
For the best viewing experience, ensure ClearType screen fonts are activated. 

 

 
For additional help when logged in to IMM eSign, click the Page Help  button for 
more information about the page. 

 

 
Options and buttons shown in this guide will vary if working on a session created in an 
older version of IMM eSign.  

 

IMM eSign Static Documents vs. Dynamic Documents (RTS Only) 
A static document is one that will always be the same length, and all information in a static 
document will always be in the same place. The Signature Field and Signature Date Field will 
always be in the same locations on the same page. The document will always have the same 
number of pages. 
A dynamic document can vary in the number of pages included. A mortgage document may 
sometimes be one page long and nine pages or more in other cases. Typically, these 
documents require that an applicant read all of the information and then sign the document at 
the end, attesting that the applicant has read the required information. In a dynamic document 
the Signature Field and Signature Date field can always be at the end of the document 
regardless of the number of pages included. 

Third-Party Attachments 
IMM eSign can identify signature fields in third-party documents, such as Gap Agreements, and 
use those fields to collect signatures as part of a single, streamlined signing experience. This 
eliminates the need to use Document Designer to add signature fields. 
Third parties designate fields differently. As such, IMM eSign identifies and understands the 
differences of each third-party document. IMM eSign determines the originating third party and 
then utilizes the appropriate method to extract and identify the signature locations, party 
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information, and all necessary fields to process the signature. If the signature method is 
identified, the document is attached to the session and processed. When there are optional 
signatures, the signature/initials fields must be reviewed in Document Designer before the 
session can be signed. The third party must be integrated to automate the identification and 
processing of these types of documents. 

XML Documents 
IMM eSign XML documents are created using LiquidOffice Forms Designer. IMM eSign only 
supports PDFs built with LiquidOffice Forms Designer. DO NOT use any other PDF designer 
tool to create or modify PDFs for IMM eSign. The LiquidOffice Forms Designer maps fields 
using the Field Data dictionary. Once fields are mapped, the PDF is uploaded to IMM eSign. 
IMM eSign merges the XML data generated by the business application with the uploaded PDF. 
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Getting Started 

 
Windows Fast User Switching is not supported. 

 

 
Using IMM eSign on a tablet may require the use of a tablet-specific stylus. 

 

 
Do not use the Internet Explorer Back button while processing document sessions. 

 
This guide assumes all IMM eSign components have been installed and set up. Contact your 
administrator for assistance, if necessary. 
This section provides an overview of how to use IMM eSign. 
Refer to IMM eSign Menus on page 137 for a detailed description of the IMM eSign menus and 
the tasks associated with each page. 

Starting IMM eSign Client (RTS Only) 
After IMM eSign Client has been successfully installed, it must be started to access Settings.  

1 Click Start > IMM > Client Application to start IMM eSign Client. 

2 

The Enter eSign Credentials window is 
displayed with the Host System FI ID 
populated from installation the first time any 
user starts IMM eSign Client. 

• Host System FIID: Preset during 
installation. 

• Domain: Preset during installation. 

• User ID: ID of user logging into IMM 
eSign Client based on the Windows 
login.  

 
The user ID must be created by 
the FI Admin prior to this step (if 
Auto Create User is not set to 
Create and Activate [HostAdmin]). 

• RTS Password: IMM eSign password established when the FI is created. 
After completing the RTS Password, click OK to continue. 

 
This screen will not display if Suppress Logons was selected by your 
administrator during installation. 
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3 A If this warning is displayed, click OK. 

 
1. IMM eSign will not be 

functional until 
credentials are correctly 
set up. 

2. In some installations, 
this warning may display 
if the User ID has not 
been previously created 
by the FI Administrator. 

 

 

B Right-click on the IMM eSign Client system tray icon . Refer to IMM eSign 
Icon on page 184 for details.  

C Click Exit.  

D Contact the FI Administrator.  

 

Logging In (RTS Only) 
Manually log in to IMM eSign using this procedure: 

1 Right click the IMM eSign icon in the system tray, and then click Search Active Sessions 
or Search Completed Sessions. 

2 IMM eSign opens in a web browser and displays either the Search Active Sessions page 
or Search Completed Sessions page depending on what you selected. Your User ID is 
displayed in the menu. 
For more information about the IMM eSign icon, refer to IMM eSign Icon on page 184. 
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Creating Documents (RTS Only) 
In order to process a document or document session, documents must first be converted to 
PDF format. If the document you are processing is already in PDF format, proceed to 
Loading Documents on page 11. 
If your core system automatically creates PDF documents as you process loans or 
membership information, proceed to Previewing and Printing Documents.  
 To create a PDF document for processing, use the eSign Printer: 
1. Open the document.  

 
This is an example of a Microsoft 
WordPad document that is being 
printed using the eSign Printer. 
Documents can be printed from any 
application that has the ability to 
print to a Windows printer. 

2. Click File > Print. 
3. Select eSign Printer. 
4. Click Print. The document will be converted 

to PDF format and placed in the Output 
folder. 

5. Repeat as necessary to create additional 
PDFs. 
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Loading Documents (RTS Only) 
There are two locations to load a document: the Manual Output folder and the Output folder. 
Confirm documents are defined before loading them to the Manual Output folder or the Output 
folder. If documents are not defined, refer to Processing Undefined Documents on page 59 
for details. 

 
Documents should be no larger than 1.5 to 2.5 MB in size for the best eSign 
processing experience. 

 

 
IMM eSign web browsers on IMM eSign Client machines must be closed before 
loading documents. 

Manual Output Folder 
PDFs placed in the Manual Output folder will not be loaded until the user directs IMM eSign to 
proceed. 
Copy and paste the PDF document(s) into the Manual Output folder (Program Files > IMM > 
TotaleSign > Client > ManualOutput). 
When the icon's background is green ( ), it indicates that there are documents in the Manual 
Output folder waiting to be processed. 

To process the PDFs placed in the Manual 
Output folder, right-click on the IMM eSign 
icon  in the system tray, and then click 
Show Documents. 
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Reorder, delete, and preview documents in 
the Documents List window as necessary.  
• Preview ( ): Select a document and 

click this button to display the selected 
PDF document in separate window. Only 
one document can be previewed at a 
time from the Documents List popup. 
Documents can be printed by clicking 
the Print icon. Close the window to 
continue. 

• Delete Documents: Click this button to 
unlock the Delete ( ) button. Select a 
document. Click the Delete button. 
When asked to confirm your action, click 
Yes. The document is deleted. 

• Reorder Documents: Click this button 
to unlock the Up/Down ( / ) arrows. 
Select a document. Change that 
document’s order in the list by clicking 
on the Up or Down arrow. Click Reorder 
Documents again to accept the order. 

• Close: Click this button to close the 
Documents List window without saving 
changes. 

When you are ready to process the 
documents as a session, click Continue.  

 

If there are multiple documents, a 
processing message will appear for each 
document being processed. 

 

The status changes to Closing document 
session after all documents are processed 
and loaded. The Session Details page in 
IMM eSign opens. Refer to Session Details 
on page 152 for an overview of the Session 
Details page. 
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If there are problems processing the 
document, the Exceptions window is 
displayed.  

1. Enter any descriptive text so this 
incident can be referred to later. 

2. Click OK. 
Refer to IMM eSign Icon on page 184 for 
more information. 

 

 

Output Folder 
PDF documents placed in the Output folder will be automatically loaded to IMM eSign. 
Copy and paste the PDF document(s) into the Output folder (Program Files > IMM > 
TotaleSign > Client > Output). 

If there are multiple documents, a processing 
message will appear for each document 
being processed. 

 

The status changes to Closing document 
session after all documents are processed 
and loaded. The Session Details page in IMM 
eSign opens. Refer to Session Details on 
page 152 for an overview of the Session 
Details page. 

 

 
If there are problems processing the 
document, the Exceptions page will be 
displayed.  
Enter any descriptive text so this incident 
can be referred to later. 
Click OK. 
Refer to IMM eSign Icon on page 184 for 
more information. 
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Creating a New Session (XML Only) 
An XML session is created two ways: 

• Data is passed from the core/host system. Refer to Adding and Deleting Documents for a 
New Session. 

• In IMM eSign, click Processing > Create New Session. Refer to Creating a New Session 
in IMM eSign. 

Adding and Deleting Documents for a New Session 
When data is passed from the core/host system, the New Session page is automatically 
launched in IMM eSign. A document set is preselected in most cases. 

 

1 If desired, add documents using the Add 
Documents area. Refer to Adding Documents 
on page 60 for more information about adding 
documents from the document library, attaching 
external documents, scanning items, and 
adding photographs to this session. For IMM 
eSign plus integrations, only the Library tab is 
available. 
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2 Review the Selected Documents area and make changes as necessary. Refer to Create 
New Session (XML Only) on page 138 for details about the icons and controls on this 
page. 

 

3 Once you are done making changes to the session, click Process. Refer to Processing 
Documents on page 57 for details.  
Once the documents are processed, the Session Details page is displayed. Refer to 
Session Details on page 152 for details. 
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Creating a New Session in IMM eSign 
A new XML session can be created in IMM eSign by clicking Processing > Create New 
Session. From the New Session page, add documents and create a new session by following 
these steps: 

1 If applicable, select a platform from the Platform dropdown. 

 

2 Select Documents to choose from all of the 
documents, or select Sets to choose 
documents based on the document set.  
Use the Search field to search for 
documents or document sets by name and 
description. When Documents is selected, 
the search results only display documents. 
When Sets is selected, the search results 
display documents and document sets.  
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3 If you selected Documents in Step 2, the Documents Library is displayed. To select 
documents, click Select Document  next to the desired documents. If Select 
Document  is not available for a particular document, then that document is already 
included. 
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 If you selected Sets in Step 2, the Document Sets Library is displayed. To select all of the 
documents in a document set, click Select Document Set . To select specific 
documents in a document set, click the document set title row to expand it. Then, click 
Select Document  next to the desired documents. If Select Document  is not 
available for a particular document, then that document is already included. If Select 
Document Set  is not available, then at least one document from the document set is 
already included.  
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4 Once a document is selected, the Selected Documents area displays all of the chosen 
documents. The documents listed in the Selected Documents area will not be available in 
the Documents Library or Document Sets Library again for that session unless the 
documents are deleted from the Selected Documents area. 
Make changes to the Selected Documents area as necessary. Refer to Create New 
Session (XML Only) on page 138 for details about the icons and controls on this page. 

 

5 Once you are done adding documents to the session, click Process. Refer to Processing 
Documents on page 57 for details.  
Once the documents are processed, the Session Details page is displayed. Refer to 
Session Details on page 152 for details. 
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Processing Add-Ons 
If the Loan Coupons and/or Starter Checks add-ons have been activated, you will see the 
Processing > Loan Coupons and/or Processing > Starter Checks menu options. When one 
of these options is clicked, the Add-Ons Processing page is displayed. 

Processing Loan Coupons 
1 Click Processing > Loan Coupons to display the Add-Ons Processing page. 

Prepopulated data cannot be edited on this page. 

 

2 Enter information in the fields as necessary. Fields marked with a red asterisk (*) must be 
completed.  
 

 
To determine the Coupon Start Number for parties who have had Loan 
Coupons before, refer to the Starting # column and the Coupons/Printed 
column from the Add-Ons Report. For example, if the most recent Starting # is 
1 and Coupons/Printed is 12, the next Coupon Start Number is 13. Refer to 
Add-Ons on page 175 for details about generating an Add-Ons Report. 
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3 Click Process Loan Coupons. The Loan Payment Coupon Book is displayed. 

 

4 Print the Loan Coupons from this popup. 
 

 If printing to a duplex capable printer, ensure the setting is not set to duplex. 
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Processing Starter Checks 
1 Click Processing > Starter Checks to display the Add-Ons Processing page. 

Prepopulated data cannot be edited on this page. 

 

2 Enter information in the fields as necessary. Fields marked with a red asterisk (*) must be 
completed.  
 

 
To determine the Check Start Number for parties who have had Starter 
Checks before, refer to the Starting # column and the Checks Printed column 
from the Add-Ons Report. For example, if the most recent Starting # is 1 and 
Checks Printed is 12, the next Check Start Number is 13. Refer to Add-Ons 
on page 175 for details about generating an Add-Ons Report. 
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3 Click Process Starter Checks. The Starter Checks are displayed. 

 

4 Print the Starter Checks from this popup. 
 

 If printing to a duplex capable printer, ensure the setting is not set to duplex. 
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Previewing and Printing Documents 
Preview 

 
Preview may not be available for your installation. Contact your Administrator for more 
information. 
Documents can be previewed from two locations: the Session Details page and the 
eSignature Management page. 
Documents may be viewed or printed only 
Documents cannot be edited or saved in Preview mode. 

 
From the Session Details page, click the 
Preview icon to view a single document in a 
PDF popup window.  
Click the Preview icon for the Document Set to 
view all documents in the set in a PDF popup 
window. Use the scroll bar to view multiple 
documents. 
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Print 
To print documents, click the Preview icon. In the Adobe popup window, click the printer icon. 

 

 

The Print window is displayed. Change the 
print options as necessary. Click Print. To 
cancel printing, click Cancel or close the 
Print window.  
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Using Document Designer 

 
Signed documents cannot be modified. 
Document Designer is not available for iPad users except when there are 
unmapped/optional fields. When unmapped or optional fields are detected, you are 
rerouted to the Document Designer page instead of the eSignature Management 
page. 
Document Designer is not available for eSign Lite installations. 
For XML sessions, full Document Designer functionality is only available for 
attachments. Document Designer is not available for XML documents. XML 
documents cannot be modified. 
In this section, screenshot examples reflect RTS sessions except where noted.  

Overview 
You can access the Document Designer from the Session Details page or eSignature 
Management page.  
Refer to Document Designer on page 155 for details on the Document Designer page. 

Navigate to the desired document using the up  or down  arrows or by clicking the 
document name in the Documents list.  
This is an example of an RTS document in Document Designer. For RTS sessions, the 
Document Designer page allows you to assign a template to unknown documents, map 
unmapped fields, and set optional fields as required or not. You can add, edit or delete 
signature fields, signature date fields, initial fields, textboxes, checkboxes, and dropdown lists. 
In addition, this page can also be used to add, edit or delete signer (party) information. Using 
the Request Attachments button, attachments can be requested from remote parties. Once 
requested, remote attachments are listed in the Documents list on the Document Designer 
page.  
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This is an example of an XML document in Document Designer. For XML sessions, the 
Document Designer page allows you to set optional fields as required or not. For attachments, 
you can add, edit or delete signature fields, signature date fields, initial fields, textboxes, 
checkboxes, and dropdown lists. Using the Request Attachments button, attachments can be 
requested from remote parties. Once requested, remote attachments are listed in the 
Documents list on the Document Designer page.  
For XML sessions, signer (party) information cannot be added, edited, or deleted. XML 
documents cannot be modified unless they are attachments.  
The following example displays the Review Optional button because optional signatures/initials 
are detected. When optional signatures/initials are not detected, the Review Optional button is 
not displayed. 

 
Refer to RTS-Only Procedures on page 28 for more information about using Document 
Designer in an RTS environment. Refer to XML-Only Procedures on page 39 for more 
information about using Document Designer in an XML environment. 
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RTS-Only Procedures 
Assigning a Template to Undefined Documents 
When a document that has not been defined is processed, individually or as a part of a set, the 
document appears on the Session Details page using the naming convention assigned by your 
FI Administrator.  

 
The default naming convention for unknown documents is “Undefined.” “Undefined” is 
used throughout this section as an example. The naming convention is configurable 
by your FI Administrator. 

 

 
The undefined document will not be archived until it has been assigned to a template. 
An undefined document cannot be archived. Document sets containing undefined 
documents cannot be archived. Other documents in the set can be individually 
archived if they do not have any unsigned signature fields. 
The document set remains as a saved session. This allows your administrator to 
define the document or remove the document from the document set. 
Editing index information for undefined documents may result in invalid index 
information. 
When the document is defined, index values from the document may overwrite the 
values entered at this time. 
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When the undefined document is expanded on the Session Details page, the indexing 
information is not available. Refer to the following example. 

 
To assign a template to undefined documents, click Design on the Session Details page to 
open the Document Designer page. 

1 On the Document Designer page, click the Template dropdown and select a template 
from the list, or click Remove to delete the undefined document from the document set. 

 
When Remove is selected for an undefined document, a check mark appears in the 
button and the Template dropdown is disabled.  

 
To cancel the deletion, click Remove again. The check mark will disappear and the 
Template dropdown will become enabled again. 
Undefined documents are not deleted from the set until the Apply button is clicked. 
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2 If there is more than one undefined document, click Next to move to the next document. 
Repeat Steps 1 and 2 for each undefined document. 

 
To move to a previous document, click Previous. 

3 When you are done assigning templates and removing undefined documents, click Apply. 
The templates are assigned to the documents and undefined documents are deleted from 
the document set.  

 
If unmapped or optional fields are detected, the Document Designer page refreshes in the 
Manage Unmapped Fields mode. Refer to Managing Unmapped and Optional Fields on 
page 31. 
If no unmapped or optional fields are detected, the Document Designer page refreshes. 
Refer to Reviewing Assignments on page 33 to continue making changes to the 
document set in Document Designer. 

4 After a template is assigned to a document and changes are applied, the document 
information is updated on the Session Details page. 
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Managing Unmapped and Optional Fields 

 
Document Designer is not available for iPad users except when there are 
unmapped/optional fields. When unmapped or optional fields are detected, you are 
rerouted to the Document Designer page instead of the eSignature Management 
page. The Document Designer page opens in Manage Unmapped Fields mode. 

 

 
Optional signatures are configured by your Administrator in AIM. 

 
When unmapped or optional fields are detected, the Document Designer page opens in Manage 
Unmapped Fields mode. If you review optional signatures/initials and then add a third-party 
document that has optional signatures, you will be prompted to review all fields in the session 
again. 
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1 In the popup window that is displayed on the Document Designer page, select the 
information as necessary. 

 
 1 Click Add Signer if the signer is not listed in the Signers list on the Document 

Designer page. Refer to Add Signer on page 37 for details about adding a signer. 
 2 Select a signer using the dropdown list if the field is not autopopulated. 
  3    If the Required checkbox is editable, this field is an optional field. Select Required if 

the signer must enter a signature or initial in the field. If the Required checkbox is 
not selected, the signer will not enter a signature or initial in the field. If the Required 
checkbox is selected and not editable, the field is not optional and the signer must 
enter a signature or initial in the field.   

  4    When changes are complete, click Next to navigate to the next field. 
After the first field is done, the popup also displays a Back button. Click the Back 
button to navigate to the previous field or click the Next button to navigate to the next 
field. At the last unmapped/optional field, the Next button is replaced with the Done 
button. 

1 

 

2 

 

3 

 

4 
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2 When you are finished, click Done. You are exited from Manage Unmapped Fields mode.  

 

Reviewing Assignments 
1 On the Document Designer page, click Review Assignments. 
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2 In Review mode, navigate to each signature/initial field in the document set using the 
Next button. 

Edit the signer assigned to the field by clicking the  icon. 
Exit Review mode by clicking the Exit Review Mode button and then clicking Exit in the 
confirmation window. 
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3 In the popup window that is displayed after clicking the  icon, select a different signer 
using the dropdown list or click Add Signer to add a new signer. Refer to Add Signer on 
page 37 for details about adding a signer. 

 
When changes are complete, click Next to navigate to the next signature/initial field. 
After the first signature field, the popup displays Back and Next buttons as shown below. 
Click the Back button to navigate to the previous signature/initial field or click the Next 
button to navigate to the next signature/initial field. 
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4 At the last signature/initial field in the document set, the Next button is replaced with the 
Done button. 

 
If editing the signer assigned to the last field, the Next button in the popup window is also 
replaced with Done. 

 

5 When you are finished reviewing the signature/initial field assignments, click Done on the 
Document Designer page or in the popup window. You are exited from Review mode. 
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Adding, Editing, and Removing Signers 
Add Signer 

1 From the Document Designer page, click Add Signer. 

 

2 Complete the Signer Name and Email 
information.  
Click Save.  

 

3 The new signer will be added to the list of 
Signers and displays yellow, indicating the 
signer is not associated with any signature 
fields in any documents. 
This signer can now be associated with a 
signature/initial field within the session. 
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Edit Signer 

1 From the Document Designer page, 
double-click the name of the signer to be 
edited. 

 

2 Edit the Signer Name and Email 
information.  
Click Save.  

 

Remove Signer 
Signers cannot be removed from the list until fields associated with that signer have been 
removed from all documents. 

1 From the Document Designer page, click 
the name of the signer to be deleted. 
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2 Click Remove Signer. If the signer is still 
associated with fields in the session, the 
Remove Signer button will not be 
displayed. 
Click OK on the confirmation popup. 
The signer is removed from the Signers 
area. 

 

XML-Only Procedures 
Reviewing Optional Signatures/Initials 

 
Optional signatures are preconfigured in third-party documents or uploaded PDFs. 

 
When optional signatures and initials are detected in third-party documents or uploaded PDFs, 
the Document Designer page opens in Review mode and displays the Review Optional button. 
If you review optional signatures/initials and then add a third-party document that has optional 
signatures, you will be prompted to review all optional signatures/initials in the session again. 
Parties cannot be added or edited. 

 
Exit review mode by clicking the Exit Review Mode button and then clicking Exit in the 
confirmation window. To return to Review mode, click Review Optional. 
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To review the optional signatures and initials, perform the following procedure: 

1 Select the Required checkbox to collect a signature or initial in that field. 

 

Alternatively, click the  icon to open the field popup and select the Required checkbox 
to collect a signature or initial in that field. 

 
If the Required checkbox is not selected, the signer will not provide a signature/initial for 
that field. 

2 Navigate to each signature/initial field in the document set using the Next button. 
After the first field, the popup displays Back and Next buttons as shown below. Click the 
Back button to navigate to the previous signature/initial field or click the Next button to 
navigate to the next signature/initial field. 
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 At the last signature/initial field in the document set, the Next button is replaced with the 
Done button. 

 
The Next button in the popup window is also replaced with Done. 

 

3 When you are finished reviewing the optional signatures/initials, click Done. You are 
exited from Review mode. 
To get back to Review mode, click Review Optional. 
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Moving and Resizing Fields 
After a field is placed, it can be repositioned or resized.  

Moving Fields 
Move – 4-Headed Arrow 
1. Hover the mouse pointer over the field until 

the 4-headed arrow pointer is displayed.  
2. Drag the field to the desired location on the 

document. 
3. Release the mouse pointer to drop the field 

in the new location. 

 

Resizing Fields 
Resize – 2-Headed Arrow 
1. Hover the mouse pointer over the field until 

the 2-headed arrow pointer is displayed.  
2. Position the Arrow on a corner of the field 

box and drag to the desired size  
3. Release the mouse when the desired field 

size is achieved. Repeat the process for 
height and/or width sizing. 

 

Adding, Editing, and Deleting Fields 
When a document has been selected and opened from the Document Designer page, any of 
the following fields can be added and defined using the Document Designer:  
Signature and Initial Fields 
Textbox Fields 
Checkbox Fields 
Dropdown Fields 
 
Signature and Initial Fields 
Add Signature and Initial Fields 

1 On the Document Designer page, select the signer from the Signers list to associate a 
field with a signer, and select the document from the Documents list. 
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2 Click and drag the Signature or Initial button into the document to place the field. 

 
Signature/Initial fields not associated with a signer will display in red. 
Signature/Initial fields associated with a signer will display in green. 

3 After the field is placed, it can be repositioned or resized. Refer to Moving and Resizing 
Fields on page 42. 

4 Double-click the field to open the Signature or Initial Field Information popup. 

Signature Field Not Associated with a Signer 

 
• Select a Signer from the dropdown list. 

• Click Add Signature Date to add a 
signature date field. 

Signature Field Associated with a Signer 

 
• Click Add Signature Date to add a 

signature date field. 
 

Click Save when complete. 
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Edit or Delete Signature and Initial Fields 
Double click on the signature, signature date, or initial field to open the Signature Field 
Information or Initial Field Information popup. Double-clicking on a Signature Date field will open 
the associated Signature Field Information popup. 

Signature Field 

 
The Signature Date field can be removed 
without affecting the signature field. 

Initial Field 

 
 

To edit the field, modify the field information as necessary, and then click Save. 
To delete the field, click Delete. Deleting a signature field will also delete any associated 
signature date field. 
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Textbox Fields 
Add Textbox Fields 

1 Click and drag the Textbox button into the document to place a textbox. 

 
Textbox fields not associated with a signer, role or type will display in red. 
Textbox fields associated with a signer, role or type will display in green. 

2 After the field is placed, it can be repositioned or resized. Refer to Moving and Resizing 
Fields on page 42. 
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3 Double-click the field to open the Textbox Field Information popup. 

Textbox Field Not Associated with a  
Signer, Role or Type 

 

Textbox Field Associated with a  
Signer, Role or Type 

 

 1 Role/Type: The Role/Type of this field when processed through IMM eSign. Enables 
or disables the field based on signer. 
 Generic Locked: Locked if any signer has signed the session. (In branch 

processing only) 
 Generic Unlocked: Always unlocked regardless of signature status. (In branch 

processing only) 
 Party: Field will be locked/disabled after the selected party has signed all 

documents in the session. 
 2 Current Value: If the document has not been processed, this will be the default 

value. If the document has been processed, this field will update to show any 
changed value. 

 3 Keep Unlocked for the selected party in remote signing: When checked, this 
keeps the field unlocked when signing remotely. (Only enabled when item 1 is a 
party.) 

 4 Must Enter Value: Requires the field to be populated when signing remotely. (Only 
enabled when item 1 is a party and item 3 is checked.) 

 5 Action Buttons:  
 Click Save to save and continue.  
 Click Cancel to prevent saving changes. 
 Click Delete to remove the current field. 

1 

 

2 

 

3 

 
4 

 
5 
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Edit or Delete Textbox Fields 
Double click on the textbox field to open the Textbox Field Information popup. 

 
To edit the textbox field, modify the field information as necessary, and then click Save. 
To delete the textbox field, click Delete. 

Checkbox Fields 
Add Checkbox Fields 

1 Click and drag the Checkbox button into the document to place the field. 

 
Checkboxes not associated with a signer, role or type will display in red. 
Checkboxes associated with a signer, role or type will display in green. 

2 After the field is placed, it can be repositioned or resized. Refer to Moving and Resizing 
Fields on page 42. 
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3 Double-click the field to open the Checkbox Field Information popup. 

Checkbox Field Not Associated with a  
Signer, Role or Type 

 

Checkbox Field Associated with a  
Signer, Role or Type 

 
 

 1 Role/Type: The Role/Type of this field when processed through IMM eSign. Enables 
or disables the field based on signer. 
 Generic Locked: Locked if any signer has signed the session. (In branch 

processing only) 
 Generic Unlocked: Always unlocked regardless of signature status. (In branch 

processing only) 
 Party: Field will be locked/disabled after the selected party has signed all 

documents in the session. 
 2 Current Value: Checked or Unchecked. If the document has not been processed, 

this will be the default value. If the document has been processed, this field will 
update to show any changed value. 

 3 Caption: Create a caption for a checkbox field. After the field information has been 
saved, the caption region can be moved and resized as necessary. 

 4 Keep Unlocked for the selected party in remote signing: When checked, this 
keeps the field unlocked when signing remotely. (Only enabled when item 1 is a 
party.) 

 5 Must Enter Value: Requires the field to be populated when signing remotely. (Only 
enabled when item 1 is a party and item 3 is checked.) 

 6 Action Buttons:  
 Click Save to save and continue.  
 Click Cancel to prevent saving changes. 
 Click Delete to remove the current field. 

1 

 

2 

 

3 

 

4 

 

5 

 

6 
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Edit or Delete Checkbox Fields 
Double click on the checkbox or its caption field to open the Checkbox Field Information popup. 

 
To edit the textbox field, modify the field information as necessary, and then click Save. The 
Checkbox Caption can be removed without affecting the checkbox field. 
To delete the textbox field, click Delete. Deleting a checkbox field will also delete any 
associated caption field.  

Dropdown Fields 
Add Dropdown Fields 

1 Click and drag the Dropdown button into the document to place the field. 

 
Dropdown field information must always be updated, even when it is associated with a 
signer. As such, added Dropdown fields will always be displayed in red. 

2 After the field is placed, it can be repositioned or resized. Refer to Moving and Resizing 
Fields on page 42. 
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3 Double-click the field to open the Dropdown Field Information popup. 

Dropdown Field Not Associated with a  
Signer, Role or Type 

 

Dropdown Field Associated with a  
Signer, Role or Type 

 

 1 Role/Type: The Role/Type of this field when processed through IMM eSign. Enables 
or disables the field based on signer. 
 Generic Locked: Locked if any signer has signed the session. (In branch 

processing only) 
 Generic Unlocked: Always unlocked regardless of signature status. (In branch 

processing only) 
 Party: Field will be locked/disabled after the selected party has signed all 

documents in the session. 
 2 Dropdown values: These will be the values a signer can choose from when signing 

a document. 
 3 Current Value: If the document has not been processed, this will be the default 

value. If the document has been processed, this field will update to show any 
changed value. 

 4 Keep Unlocked for the selected party in remote signing: When checked, this 
keeps the field unlocked when signing remotely. (Only enabled when item 1 is a party.) 

 5 Must Enter Value: Requires the field to be populated when signing remotely. (Only 
enabled when item 1 is a party and item 4 is checked.) 

 6 Action Buttons:  
 Click Save to save and continue.  
 Click Cancel to prevent saving changes. 
 Click Delete to remove the current field. 

1 

 

2 

 

3 

 

4 

 

6 

 

5 
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Edit or Delete Dropdown Fields 
Double click on the dropdown field to open the Dropdown Field Information popup. 

 
To edit the dropdown field, modify the field information as necessary, and then click Save. 
To delete the dropdown field, click Delete. 

Requesting Attachments 
Supporting documents such as pay stubs, W2s, Driver License, Passport, etc. can be requested 
as required from a remote signer by using the Request Attachments option.  

 
The Request Attachments button is only enabled for sessions that will be sent for 
Remote Signature. 
Attachments can be requested from the Document Designer page or the eSignature 
Management page. 
Encrypted PDF documents cannot be attached. 
Attached documents must be less than 5 MB in size. 
A maximum of 10 documents can be attached per session.  
A maximum of 100 document pages can be attached when the session will be sent for 
remote signatures. 
Supported file formats are BMP, GIF, JPEG, JPG, PDF, PNG, TIF, and TIFF. 
Attachments will be downloaded as PDF documents. All attachments will be converted 
to PDF documents and saved as separate files. 

 
Prior to requesting attachments, a signer must be designated to sign remotely. Refer to 
eSignature Management on page 158 for details.  
To request remote attachments, perform the following procedure: 
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1 On the Document Designer page or eSignature Management page, click Request 
Attachments. 

2 If the Session Confirmation page is displayed, review the confirmation and click 
Continue. Refer to Confirming Changes on page 57 for details. 

3 On the Request Remote Attachments page, select a template from the Attachment 
Template dropdown.  

 
Click Cancel to return to the previous page. 
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4 The Request Remote Attachments page refreshes and lists all documents associated with 
the attachment template. 
All signers are automatically selected. Deselect signers who will not be supplying remote 
attachments. 
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5 For each signer, click Select Index Source Document. 

 
The Index Source Document field is not applicable to XML sessions. 

 

 
The Request Remote Attachments page refreshes listing all indexed documents in the 
session.  
Click to select a document as the index source for that signer. 
Different index sources may be used for additional signers. 
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6 The Request Remote Attachments page refreshes and displays all preselected 
attachments for the template.  

 
For each pre-selected attachment in the template, 
 1/2 Title/Description: This information is fixed and cannot be changed. 
 3 Required Checkbox: When checked, the attachment will be a requirement for the 

signer during remote signing. When this is not checked, providing the attachment will 
be an option for the signer.  

 4 Delete Icon: Click the icon to remove the attachment from the template for this 
session. 

 5 To add additional remote attachments,  
1. Select an attachment from the Select Attachment dropdown. 
2. Check Required to require the attachment from the signer during remote signing. 

When this is not checked, providing the attachment will be an option for the signer. 
3. Click Save. Click Clear to not add the additional remote attachment. 

 6 Request Remote Attachments Action Buttons:  
 Click Save to save remote attachments options and return to the previous page 

(Document Designer page or eSignature Management page). 
 Click Cancel to exit remote attachments options without saving changes. 

1 

 

2 

 

3 

 

4 

 

5 

 

6 
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7 When returning to the Document Designer, the requested remote attachment entry will 
display in the Documents list. When the requested remote attachment entry is selected, 
the requested remote attachments are listed.  

 
Required remote attachments have a red border. 
Remote attachment requests cannot be modified on this page. 



  IMM eSign 2018.1 
  User/Document Administrator Guide  

 

Rev. 2/27/19  57 

Confirming Changes 
The Session Confirmation page is displayed in some installations (FI Administrator setting) after 
all signatures have been assigned, all other changes completed, and the Continue button is 
clicked in Document Designer.  

 
After reviewing the page, 

• Click Edit in Designer to return to the Document Design page. 

• Click Continue to return to the page where the Document Designer page was accessed 
from. 

Processing Documents 

 
This feature is not available for iPad users. 

 
Click Process to process and update the session. 

Selecting a Workflow 
For IMM eSign plus sessions that have not been assigned a workflow, the Select Workflow 
popup is displayed when Process is clicked. If the session only has one possible workflow, the 
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Select Workflow popup will not be displayed. The following screenshot is an example. The 
visible fields are dependent on your integration and configured by your administrator.  

 
1 Workflow: Select a workflow from the Workflow field to assign the session to a workflow. 
2 Submit or Cancel: Click Submit to save changes and proceed. Click Cancel to exit the 

Select Workflow popup without saving changes. 

Verifying Information 

 
Do not use the Internet Explorer Back button while processing document sessions. 

Click Process on the Session Details page. 
The documents marked for display will open. 
When the Highlight Fields button is selected, 
fields that can be modified will display in a 
different color. 
 

 
The Tools, Sign and Comment buttons on the Adobe Reader menu should not be 
used in IMM eSign. 

 
Verify and enter any required information. 

• Cancel Session: Clicking this button will cancel the current session. The documents, 
any changes made and the session will be discarded. 

• Continue: When all changes have been made to the current document, click this 
button to continue to the next document. If there are no more documents to process, 
you will continue to the Documents Submitted page. 

1 

2 
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Changing Text Fields and Checkboxes 
As the documents appear, scroll to a text 
box or checkbox. 
The first time a text field, checkbox or 
signature field is selected, the Cannot Save 
Form Information page is displayed. 
Select Don’t show again. 
Click Close to continue. 

 

Make changes as necessary. 
To cancel the session, click Cancel 
Session. 
To continue with the session, click 
Continue. 
 

 

Processing Undefined Documents 
When a document that has not been defined is processed, individually or as a part of a set, the 
document appears on the Session Details page using the naming convention assigned by your 
FI Administrator (e.g., “Undefined”). A session with an undefined document can only be partially 
processed. 

 
The default naming convention for unknown documents is “Undefined.” “Undefined” is 
used throughout this section as an example. The naming convention is configurable 
by your FI Administrator. 

 

 
The undefined document will not be archived until it has been assigned to a template. 
An undefined document cannot be archived. Document sets containing undefined 
documents cannot be archived. Other documents in the set can be individually 
archived if they do not have any unsigned signature fields. 
The document set remains as a saved session. This allows your administrator to 
define the document or remove the document from the document set. 
Editing index information for undefined documents may result in invalid index 
information. 
When the document is defined, index values from the document may overwrite the 
values entered at this time. 
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Assign a template to undefined documents to proceed. Refer to RTS-Only Procedures 
Assigning a Template to Undefined Documents on page 28 for details. 

Adding Documents 

 

Encrypted PDF documents cannot be attached. 
Attached documents must be less than 5 MB in size. 
A maximum of 10 documents can be attached per session.  
A maximum of 100 document pages can be attached when the session will be sent for 
remote signatures. 
Supported file formats are BMP, GIF, JPEG, JPG, PDF, PNG, TIF, and TIFF. 
Attachments will be downloaded as PDF documents. All attachments will be converted 
to PDF documents and saved as separate files. 
If using an iPad, refer to Adding Documents Using an iPad on page 70. 

 
There are three ways to add documents to the session using the Add Documents feature.  

• When the Add Docs button is clicked on the Session Details page, the Add Documents page 
is displayed. The Add Documents page allows the user to add documents from the document 
library (XML only), attach external documents, scan items, and add photographs to this 
session. Refer to the examples in this section for details. 

RTS Integrations XML Integrations 
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• (XML Only) When data is passed from the 
core/host system, the New Session page is 
displayed. The New Session page contains 
the Add Documents area. The New Session 
page allows the user to add documents from 
the document library, attach external 
documents, scan items, and add photographs 
to this session before processing. Refer to 
Adding and Deleting Documents for a New 
Session on page 14 for details about using 
this page. After processing, add documents 
to the session using the Add Docs button on 
the Session Details page. 

• (XML Only) When Processing > Create New 
Session is clicked to create a new session 
directly in IMM eSign, the New Session page 
is displayed. The New Session page contains 
a variation of the Add Documents area. The 
Library, Attach, Scan, and Photo tabs are 
not available. The page is automatically in 
Library mode. Refer to Creating a New 
Session in IMM eSign on page 16 for details 
about using this page. After processing, add 
documents to the session using the Add 
Docs button on the Session Details page. 
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Adding documents on the Add Documents page and adding documents on the New Session 
page are similar processes. The examples in this section show the Add Documents page. For 
details about the New Session page, refer to Create New Session (XML Only) on page 138. 
The Page Help button provides a quick listing of icons and functions available and related to the 
Add Documents page. 
 

  
 
 
 
 
 
 
 

 
 
1 Library (XML Only): Click Library to add documents or document sets from the library. 

This option is applicable to XML sessions only. For RTS sessions, this option is not 
displayed. For IMM eSign plus sessions, this is the only option available. Refer to Adding 
Documents from the Library for details. 

2 Attach: Click Attach to add external documents and attach them to the session. Refer to 
Attaching Documents for details. 

3 Scan: Click Scan to scan documents and attach them to the session. Refer to Scanning 
Documents for details. 

1 2 
 

4 
 

3 
 

5 
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4 Photo: Click Photo to take a photograph and attach it to the session. Refer to Taking a 
Photograph for details. 

5 Cancel: Click Cancel to go back to the Session Details page without saving. 

Adding Documents from the Library 
1 Click Library and select the desired values for each field. 

 
1 Documents or Sets: If Documents is selected, the Documents Library displays all 

of the documents in the library. If Sets is selected, the Document Sets Library 
displays documents organized by document set. 

2 Search: Use the Search field to search for documents or document sets by name or 
description. When Documents is selected, the search results display documents. 
When Sets is selected, the search results display document sets or document set 
that contain the document.  

3 Documents Library or Document Sets Library: If Documents is selected in the 
Add Documents area, the Documents Library is displayed. If Sets is selected in the 
Add Documents area, the Document Sets Library is displayed. Collapse or expand 
the library by clicking on the title row. 

1 

2 

3 
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2 In the Documents Library, add a document by clicking Select Document  next to the 
desired document. If Select Document  is not available for a particular document, then 
that document is already included. 

 
In the Document Sets Library, expand a document set by clicking on the row. Then, click 
Select Document  next to the desired document. To select all of the documents in a 
document set, click Select Document Set . If Select Document  is not available for 
a particular document, then that document is already included. If Select Document Set 

 is not available, then at least one document from the document set is already 
included. 
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3 The Selected Documents area displays the documents that you choose. The documents 
listed in the Selected Documents area will not be available in the Documents Library or 
Document Sets Library again for that session unless the documents are deleted from the 
Selected Documents area. 

 

4 When you are done adding documents, click Process to process the files and to return to 
the Session Details page. 
For IMM eSign plus integrations, you may be prompted to select a workflow when you 
click Process. Refer to Selecting a Workflow on page 57 for details. 

Attaching Documents 
Attach documents including third-party documents using the Attach option. When attaching 
supported third-party documents, signature fields and parties are automatically recognized. 
To attach documents to your sessions, follow these steps. 

1 Click Attach and select the desired values for each field. 

 
1 Attachment Type: Select an attachment type from the dropdown menu. 
2 Index Source: For XML sessions, select a party to use as an index source (shown). 

For RTS sessions, select a document to be used as an index source.  
3 Parties to View: Select one or more parties to have them view the file during the 

signing and reviewing process. 

1 

2 

3 
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2 To attach the file, either drag and drop the file from the file location into the Drop files 
here or click to select file box, or click the Drop files here or click to select file box to 
navigate to the file and select it.  

 

3 The file is uploaded automatically. The uploaded file is listed in the Selected Documents 
section.  
When you are done adding documents, click Process to process the files and to return to 
the Session Details page. 

 

Scanning Documents 

 
When the Show UI scanner setting is enabled, the 
Scan Panel popup is displayed to start and stop 
scanning. IMM recommends disabling the Show UI 
setting. Use of the Scan Panel popup is not 
recommended with IMM eSign. 

 

 Scanning attachments is only supported with Internet Explorer. 



  IMM eSign 2018.1 
  User/Document Administrator Guide  

 

Rev. 2/27/19  67 

To scan a document for this session, follow these steps: 

1 Click Scan and select the desired values for each field. 

 
1 Scanner Name: The name of the scanner is displayed here. 
2 Attachment Type: Select an attachment type from the dropdown menu. 
3 Index Source: Select a document to be used as an index source. 
4 Parties to View: Select one or more parties to have them view the file during the 

signing and reviewing process. 

2 To scan the file, click Scan.  

 

1 

2 

3 

4 



IMM eSign 2018.1  
User/Document Administrator Guide  

68 Copyright © 2019 IMM Rev. 2/27/19 

3 Once scanning is done, the uploaded file is listed in the Selected Documents section.  
When you are done adding documents, click Process to process the files and to return to 
the Session Details page.  

 

To change or set your scanner settings, refer to Workstation Scanner Settings on page 182 
for more information. 

Taking a Photograph 
To take a photograph for this session, follow these steps: 

1 Click Photo and select the desired values for each field. 

 
1 Attachment Type: Select an attachment type from the dropdown menu. 
2 Index Source: Select a document to be used as an index source. 
3 Parties to View: Select one or more parties to have them view the file during the 

signing and reviewing process. 

1 

2 

3 
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2 Once the values are entered in the fields, the camera becomes available.  

 
1 Select a camera from the dropdown menu. 
2 Click Take to take the photograph. 

3 The photograph appears.  

 
1 Click Retake to take another photograph. 
2 Click Upload Image to add the photograph to the document set. 

2 

1 2 

1 



IMM eSign 2018.1  
User/Document Administrator Guide  

70 Copyright © 2019 IMM Rev. 2/27/19 

4 When the photograph is uploaded, it appears in the Selected Documents list. 

 
If another photograph is needed, adjust the fields as necessary and use the Retake 
button to take another photograph. 
When you are done adding documents, click Process to process the files and to return to 
the Session Details page. 

Adding Documents Using an iPad 
When using an iPad, you have the ability to attach documents and add documents from the 
library (XML only).  

RTS Integrations 

 

XML Integrations 

 
 
To add documents from the library, refer to Adding Documents from the Library on page 63 
for details. 
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To attach documents, refer to the following procedure. 

 
The example screenshots in this section are based on RTS sessions. 

 

1 On the Add Documents page, select the desired values for each field, and then click 
Attach. 

 
1 Attachment Type: Select an attachment type from the dropdown menu. 
2 Index Source: For RTS sessions, select a document to be used as an index source 

(shown). For XML sessions, select a party to use as an index source. 
3 Parties to View: Select one or more parties to have them view the file during the 

signing and reviewing process.  
4 Attach: Click this button once the desired values for each field have been selected. 

1 

2 

3 

4 
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2 To attach the file, perform one of the following actions: 

• Drag and drop the file from the file location into the Drop files here or click to select 
file box.  

• Click the Drop files here or click to select file box to navigate to the file and select it. 

• Click the Drop files here or click to select file to take a picture using the iPad. 
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3 The file is uploaded automatically. The uploaded file is listed in the Selected Documents 
section.  
When you are done adding documents, click Process to process the files and to return to 
the Session Details page. 
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Routing Documents 
1 Click the Route button to route the case to the next step. The Document Routing popup is 

displayed. 

 

2 Select a workflow response from the Response drop-down menu. 

3 Select Important to mark the case as important. All cases marked as important must 
have a comment entered in the Comments field. 

4 Enter a comment in the Comments field. All cases marked as important must have a 
comment. Otherwise, this field is optional. The first 80 characters of these comments are 
added to the case’s audit report in the entry associated with document routing. 

5 Click Submit to route the document set. The Cases page is displayed. Refer to Cases 
(eSign plus) on page 166 for detailed information about the Cases page. 
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Signing Documents 

 
Signature methods available and the default signature method are set by the 
Administrator. 
For PC-touch capable devices, do not use the signature pad in-person signing 
method.  
For ViewSonic, Wacom, and Topaz GemView displays, use the in-person draw 
method. 
The signature pads shown in this section are examples only. Your signature pad will 
be different. 
The examples in this section have both signatures and initials. 
Not available for eSign Lite installations. 

 
To initiate document signing, click the Sign button on the Session Details page. The eSignature 
Management page is displayed. Refer to eSignature Management on page 158 for an 
overview of the eSignature Management page. 

 
When unmapped or optional fields are detected, you are rerouted to the Document 
Designer page instead of the eSignature Management page.  

 
This section provides an overview of the following information: 
Merging Signers 
In-Person Signing 
In-Person Viewing 
Remote Signing 
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Merging Signers (RTS Only) 
If there are two or more duplicate signers shown on the eSignature Management page, the 
names and documents of the signers can be merged. The merge functionality is not available if 
the documents are already signed. Perform the following procedure to merge signers. 

1 On the eSignature Management page, click the Merge Party Names icon next to the 
name that you would like to use to represent the signer after merging is complete.  

 

2 Click the Merge Party Names icon next to the names that you would like merged with the 
name that you selected in Step 1. 

 

3 Once the names are selected, click Merge next to the name you would like to keep.  

 
Click Cancel to undo all merge selections. 

4 The eSignature Management page refreshes and all of the selected names are merged 
into one signer. 
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In-Person Signing 
IMM eSign 2018.1 provides a simple, guided process to sign and view documents in person. 
Instead of signing in each signature field in each document, the signer creates a signature that 
is used throughout the entire signing process. Once the signature is created, the signer must 
accept the signature to confirm his or her intent to sign. Then, the signer is guided to each 
signature field where the signature can be applied with an easy click or tap.  
In addition, specific documents and attachments within a document set can be assigned to a 
party so that the party can view and approve them without the need for signatures or data entry. 
Parties can be assigned to sign, sign and view, or view certain documents within a document 
set. 
To initiate the in-person signing and viewing process on the eSignature Management page, the 
financial institution representative clicks Sign or Start:  
• When a party has documents to sign or when a party has documents to sign and documents 

to view, the Sign button is displayed.  

• When a party only has documents to view, the Start button is displayed. Refer to In-Person 
Viewing for details. 

 
When signing in person, signatures can be created using a signature pad, by typing, or by 
drawing as follows:  
Signature Pad with Messages 
Signature Pad without Messages 
Type 
Draw 
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Signature Pad with Messages 
In-person signing with the signature pad is available for traditional PCs and touch PCs. 
Signature pads display messages on the screen to improve usability and to support self-guided 
signing.  
Financial institution (FI) representatives start the signing process while the signers use a 
signature pad to create a signature, accept terms, apply the signature throughout the document 
set, and confirm completion of the signing process.  
This is a summary of how terms are reviewed, signatures and initials are created, signatures 
and initials are applied, and signatures/initials/review are confirmed: 

1. The FI representative reviews the Disclosure and Consent to the Use of Electronic 
Signatures and Records with the signer. 

2. The FI representative clicks Start below the Signature box. The signature pad displays 
“Please Sign Below.” The signer signs the signature pad and selects OK. 

3. The FI representative clicks Start below the Initials box. The signature pad displays 
“Please Initial Below.” The signer initials the signature pad and selects OK. 

4. The FI representative clicks Continue. The signature pad displays “I have reviewed the 
provided Disclosure and Consent and agree to the Terms of Use.” The signer selects 
Accept. 

5. Once the signature and the initials are created and the Disclosure and Consent and the 
Terms of Use are accepted, the first document that requires a signature is displayed in 
the IMM eSign web browser. The signature pad does not display the documents. For the 
signer to see the documents, the signer must see the IMM eSign web browser. 

6. The signer selects Sign, Initial, or Review when prompted by the signature pad to 
apply his or her signature or initials or to confirm that he or she viewed the document 
(e.g., “I hereby sign DOCUMENTNAME.”). The signer is automatically moved to the next 
field. The signer continues to select Sign, Initial, or Review on the signature pad until 
the document set is completely signed. 
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If the IMM eSign web browser displays Next, Sign/Click Here to Sign, 
Initial/Initials, or Review/Confirm Review buttons that you must click before 
the signer can apply signatures/initials or confirm review on the signature pad, 
contact your administrator. Examples of the buttons are shown below. The 
recommended Signature Pad Administration eSignature settings are outlined 
in the financial institution administrator’s guide.  
The buttons are not displayed in this section because they are not 
recommended when using the signature pad with messages. When these 
buttons are disabled as recommended, additional unnecessary clicks are 
eliminated. The buttons are ideal for scenarios where signers are using mobile 
devices like tablets.  
If the Next, Sign/Click Here to Sign, Initial/Initials, and Review/Confirm 
Review buttons are desired, refer to the detailed procedure in the Signature 
Pad without Messages section on page 91 to view the buttons as 
they appear in the IMM eSign web browser. 

      

      
 

7. When the document set is complete, the signature pad displays “I confirm that I have 
applied my signatures and have completed the signing process.” The signer selects 
Confirm Signatures. The signer is done. The IMM eSign web browser returns to the 
eSignature Management page. 

8. Repeat this self-guided process until all of the signers have signed all of the documents. 
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Refer to the following procedure for details on in-person signing with signature pads that display 
messages:  

1 After clicking Sign from the eSignature Management page, the Welcome page is displayed. 
The name and initials are automatically populated. The examples in this guide have both 
signatures and initials. 

 
 1 Review the Disclosure and Consent to the Use of Electronic Signatures and Records 

with the signer. You may print the disclosure and consent agreement by clicking the 
Print button, or simply read it by using the scroll bar. 

 2 Verify Signature Pad is selected. Your Name and Initials fields are automatically 
populated from party information in the documents. Modify as necessary. 

  3    Click Start below the Signature box and direct the signer’s attention to the signature 
pad.  

 
 

1 

 

2 

 

3 
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2 The signature pad displays “Please Sign Below.” 

 
Direct the signer to use the signature pad to create a signature. Then, the signer must 
either select Clear or Ok:  

• The signer selects Clear to remove the signature. The signer must sign again. 

• The signer selects Ok to accept the signature. After selecting Ok, it may take a few 
seconds for the signature to process. 
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3  1 On the Welcome page, the signature is displayed in the Signature box. 
 2 The Signature Start button is replaced with Clear when the signature is processed.  
 3 Click Start below the Initials box and direct the signer’s attention to the signature 

pad. 

 
 

1 

 

2 

 

3 
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4 The signature pad displays “Please Initial Below.” 

 
Direct the signer to initial the signature pad. Then, the signer must either select Clear or 
Ok:  

• The signer selects Clear to remove the initials. The signer must initial again. 

• The signer selects Ok to accept the initials. After selecting Ok, it may take a few 
seconds for the initials to process. 
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5  1 On the Welcome page, the initials display in the Initials box. 
 2 The Initials Start button is replaced with Clear when the initials are processed. 
 3 A photo can be added at this point in the signing process. To add a photo refer to 

Adding a Photo on page 115 for more information. 
 4 Click Continue and direct the signer’s attention to the signature pad. 

 
 

1 

 

4 

 

2 

 

3 
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6 The signature pad displays “I have reviewed the provided Disclosure and Consent and 
agree to the Terms of Use.” 

 
Direct the signer to select either Accept or Decline on the signature pad: 

• The signer selects Accept to use the signature, initials, and/or photo.  

• The signer selects Decline to stop this transaction. The Declining Terms popup is 
displayed on the IMM eSign web browser. As the FI representative, it is your 
responsibility to click Decline Terms to terminate the signing process and to return to 
the eSignature Management page. Prior to clicking Decline Terms, you have the 
option to provide a reason for cancelling. To continue the signing process, click Return 
to Terms. 
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7 When the signature and initials have been accepted, the first document that requires 
signing is displayed on the IMM eSign web browser. Direct the signer’s attention to the 
signature pad. 

 
Documents that require signatures or review confirmation are listed below the signer 
name. When a document is selected from the list, it will display in Preview mode. If a 
document is selected from the list, return to Signing mode by clicking the field in the 
document where the next signature is required. 
 1 The IMM eSign web browser automatically navigates to each signature, initials, and 

review field that requires a signature or initials mark or review confirmation. Before 
the signer applies the signature or initials mark or review confirmation using the 
signature pad, the field displayed in the IMM eSign web browser contains the 
message “Please wait.” Once the signer applies the signature or initials mark or 
review confirmation on the signature pad, the next signature, initials, or review field 
that requires a mark is displayed in the IMM eSign web browser with the message 
“Please wait.” This continues until the process is complete. 

 2 Print Unsigned allows you to print a copy of this document without signatures. 
 3 Cancel exits signing. The Cancelling Document Signing popup is displayed on the 

IMM eSign web browser. As the FI representative, it is your responsibility to click 
Cancel Signing to terminate the signing process and to return to the eSignature 
Management page. Prior to clicking Cancel Signing, you have the option to provide 
a reason for cancelling. To continue the signing process, click Return to Signing. 

 

Signer name 
Number of documents to be signed/reviewed 

Names of documents to be signed 
(Selected documents display in  
Preview Mode.) 

2 

 

3 

 

1 
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8 For signatures, the signature pad displays “I hereby sign DOCUMENTNAME.”  
For initials, the signature pad displays “I hereby initial DOCUMENTNAME.” 
For review confirmation, the signature pad displays “I hereby reviewed 
DOCUMENTNAME.” 
DOCUMENTNAME will be replaced by the actual name of the document being signed.  

 
Direct the signer to select Sign, Initial, Review, or Cancel on the signature pad: 

• The signer selects Sign to apply the signature, Initial to apply initials, or Review to 
confirm review.  

• The signer selects Cancel to exit signing. The Cancelling Document Signing popup is 
displayed on the IMM eSign web browser. As the FI representative, it is your 
responsibility to click Cancel Signing to terminate the signing process and to return to 
the eSignature Management page. Prior to clicking Cancel Signing, you have the 
option to provide a reason for cancelling. To continue the signing process, click Return 
to Signing. 

The signer continues to apply his or her signatures and initials or confirm review using the 
signature pad until all of the documents have been signed. 
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 To view the applied signatures or initials, locate the field in the IMM eSign web browser 
using the scroll bar and the list of documents on the left side of the page. Refer to the 
following example of an applied signature and applied initials. 
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9 When the signer is done signing all of the documents, the message “You have signed all 
documents. Click the Confirm Signatures and Finish button.” is displayed on the IMM 
eSign web browser.  
Direct the signer’s attention to the signature pad. 
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10 The signature pad displays “I confirm that I have applied my signatures and have 
completed the signing process.” 

 
Direct the signer to select Confirm Signatures or Cancel on the signature pad: 

• The signer selects Confirm Signatures to apply the signatures.  

• The signer selects Cancel to exit signing. The Cancelling Document Signing popup is 
displayed on the IMM eSign web browser. As the FI representative, it is your 
responsibility to click Cancel Signing to terminate the signing process and to return to 
the eSignature Management page. Prior to clicking Cancel Signing, you have the 
option to provide a reason for cancelling. To continue the signing process, click Return 
to Signing. 

11 On the IMM eSign web browser, you are returned to the eSignature Management page. 
Repeat this process as necessary until all of the documents have been signed by all of 
the signers. 
After all documents in the session have been signed/viewed by all parties in-person, click 
Delivery to send the documents securely to all of the signing/viewing parties. Refer to 
Secure Email Delivery on page 161 for more details. 

 
The Delivery button is only available if the parties are signing/viewing in-person. 

 
Click Continue to return to the Session Details page. 
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Signature Pad without Messages 
In-person signing with the signature pad is available for traditional PCs and touch PCs. The 
procedure in this section is for financial institution representatives who are guiding signers 
through the signing process. FI representatives control the signing process while the signers 
use a signature pad to create a signature. Unlike the Signature Pad with Messages process, 
the signature pads in this procedure do not display messages. The signature pads are only 
used to create signatures and initials. 
This is a summary of how terms are reviewed, signatures and initials are created, signatures 
and initials are applied, and signatures/initials/review are confirmed: 

1. The FI representative reviews the Disclosure and Consent to the Use of Electronic 
Signatures and Records with the signer. 

2. The FI representative clicks Start below the Signature box, and then the signer signs the 
signature pad. 

3. The FI representative clicks Start below the Initials box, and then the signer initials the 
signature pad. 

4. The FI representative clicks Accept if the signer agrees to the Disclosure and Consent 
and Terms of Use.  

5. Once the signature and the initials are created, the first document that requires a 
signature is displayed on the IMM eSign web browser. The signature pad does not 
display the documents. For the signer to see the documents, the signer must see the 
IMM eSign web browser. 

 
It is recommended to give the signer control of the IMM eSign web 
browser to apply his or her signatures and initials. 

 
6. The signer clicks Sign or Click Here to Sign (or Initial/Initials) on the IMM eSign 

browser to apply the signer’s signature or initials. The signer clicks Review and/or 
Confirm Review on the IMM eSign browser to confirm that he or she viewed the 
document. Once applied, the Next button appears.  

7. The signer clicks Next on the IMM eSign browser to move to the next field.  
8. The signer repeats steps 6 and 7 as necessary until the IMM eSign web browser 

displays “You have signed all documents.”  
9. The signer clicks Confirm your Signatures or Confirm Signatures and Finish on the 

IMM eSign browser. The signer is done. The IMM eSign web browser returns to the 
eSignature Management page. 

10. Repeat this process until all of the signers have signed all of the documents. 
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Refer to the following procedure for details on in-person signing with signature pads: 

1 After clicking Sign from the eSignature Management page, the Welcome page is displayed. 
The name and initials are automatically populated. The examples in this guide have both 
signatures and initials. 

 
 1 Review the Disclosure and Consent to the Use of Electronic Signatures and Records 

with the signer. You may print the disclosure and consent agreement by clicking the 
Print button, or simply read it by using the scroll bar. 

 2 Click Signature Pad. Clicking Signature Pad will clear the Signature and Initials 
blocks. 

  3    Click Start below the Signature box and direct the signer’s attention to the signature 
pad.  

 
  

1 

 

2 

 

3 
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2 Direct the signer to sign the signature pad. 
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3  1 On Welcome page, the signature is displayed in the Signature box. 
 2 The Signature Start button is replaced with Clear when the signature is processed.  
 3 Click Start below the Initials box and direct the signer’s attention to the signature 

pad. 

 
 
 

1 

 

2 

 

3 
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4 Direct the signer to initial the signature pad. 
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5  1 On the Welcome page, the initials display in the Initials box. 
 2 The Initials Start button is replaced with Clear when the initials are processed.  
 3 A photo can be added at this point in the signing process. To add a photo refer to 

Adding a Photo on page 115 for more information. 
 4 Click outside the box to enable the Accept button. Click Accept to use the signature, 

initials, and/or photo and to continue with the signing process. Click Decline to stop 
this transaction. The Declining Terms popup is displayed on the IMM eSign web 
browser. As the FI representative, it is your responsibility to click Decline Terms to 
terminate the signing process and to return to the eSignature Management page. 
Prior to clicking Decline Terms, you have the option to provide a reason for 
cancelling. To continue the signing process, click Return to Terms. 

 
 

1 

 

2 

 

3 

 

4 
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6 When the signature and initials have been accepted, the first document that requires 
signing is displayed on the IMM eSign web browser. 

 
Documents that require signatures or review confirmation are listed below the signer 
name. When a document is selected from the list, it will display in Preview mode. If a 
document is selected from the list, return to Signing mode by clicking the field in the 
document where the next signature is required. 
 1 Print Unsigned allows you to print a copy of this document without signatures. 
 2 Cancel exits signing. The Cancelling Document Signing popup is displayed on the 

IMM eSign web browser. As the FI representative, it is your responsibility to click 
Cancel Signing to terminate the signing process and to return to the eSignature 
Management page. Prior to clicking Cancel Signing, you have the option to provide 
a reason for cancelling. To continue the signing process, click Return to Signing. 

Signer name 
Number of documents to be signed/reviewed 

Names of documents to be signed 
(Selected documents display in  
Preview Mode.) 

1 

 

2 
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7 The signer clicks Sign or Click here to sign for signatures, Initial or Initials for initials, 
and Review and/or Confirm Review for review confirmation on the IMM eSign browser. 
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8 If more signatures are required, the signer clicks Next on the IMM eSign browser. The 
signing prompt moves to the next field. The signer repeats steps 7 and 8 until all 
documents have been completely signed. 
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9 When the signer is done signing all of the documents, the message “You have signed all 
documents. Click the Confirm Signatures and Finish button.” is displayed on the IMM 
eSign web browser. The signer clicks Confirm your Signatures or Confirm Signatures 
and Finish on the IMM eSign browser. 

 

10 You are returned to the eSignature Management page. Repeat this process as 
necessary until all of the documents have been signed by all of the signers. 
After all documents in the session have been signed/viewed by all parties in-person, click 
Delivery to send the documents securely to all of the signing/viewing parties. Refer to 
Secure Email Delivery on page 161 for more details. 

 
The Delivery button is only available if the parties are signing/viewing in-person. 

 
Click Continue to return to the Session Details page. 
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Type 
In-person signing with the type method is available for PCs and iPads. Type is the default 
signing method. The procedure in this section is for financial institution representatives who are 
guiding signers through the signing process. 
This is a summary of how terms are reviewed, signatures and initials are created, signatures 
and initials are applied, and signatures/initials/review are confirmed: 

1. The FI representative reviews the Disclosure and Consent to the Use of Electronic 
Signatures and Records with the signer. 

2. If the signer approves the prepopulated signature and initials fields, the FI representative 
clicks Accept. If the name or initials need to be modified, retype them, and then click 
Accept. 

3. Once the signature and the initials are created, the first document that requires a 
signature or review confirmation is displayed on the IMM eSign web browser. 

 
It is recommended to give the signer control of the IMM eSign web 
browser to apply his or her signatures and initials. 

4. The signer clicks Sign or Click Here to Sign (or Initial/Initials) to apply the signer’s 
signature or initials. The signer clicks Review and/or Confirm Review on the IMM eSign 
browser to confirm that he or she viewed the document. Once applied, the Next button 
appears.  

5. The signer clicks Next to move to the next field.  
6. The signer repeats steps 4 and 5 as necessary until the IMM eSign web browser 

displays “You have signed all documents. Click the Confirm Signatures and Finish 
button.”  

7. The signer clicks Confirm your Signatures or Confirm Signatures and Finish. The 
signer is done. The IMM eSign web browser returns to the eSignature Management 
page. 

8. Repeat this process until all of the signers have signed all of the documents. 
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Refer to the following procedure for details on in-person signing using the type method: 

1 After clicking Sign from the eSignature Management page, the Welcome page is displayed. 
The name and initials are automatically populated. The examples in this guide have both 
signatures and initials. 

 
 1 Review the Disclosure and Consent to the Use of Electronic Signatures and Records 

with the signer. You may print the disclosure and consent agreement by clicking the 
Print button, or simply read it by using the scroll bar. 

 2 Select Type. When Type is the default signing method (as set by the Administrator), 
the Type button is preselected. 

 3 Your Name and Initials are automatically populated from party information in the 
documents. Modify as necessary.  

 4 When the Name and Initials have been approved, click Add Photo to add a photo of 
the Signer. Refer to Adding a Photo on page 115 for more information. 

5 Click Accept to use the Signature, Initials, and/or Photo. Continue with the next step.  

1 

 

5 

 

2 

 

4 

 

3 
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  Click Decline to stop this transaction. The Declining Terms popup is displayed. Click 
Decline Terms to decline the terms and return to the eSignature Management page. 
Prior to clicking Decline Terms, you have the option to provide a reason for 
declining. To continue signing the document, click Return to Terms. 

2 When the signature and initials have been accepted, the first document that requires 
signing is displayed. 

 
Documents that require signatures or review confirmation are listed below the signer 
name. When a document is selected from the list, it will display in Preview mode. If a 
document is selected from the list, return to Signing mode by clicking the field in the 
document where the next signature is required. 
 1 Print Unsigned allows you to print a copy of this document without signatures. 
 2 Cancel exits signing. The Cancelling Document Signing popup is displayed. Click 

Cancel Signing to discontinue signing the document and to return to the eSignature 
Management page. Prior to clicking Cancel Signing, you have the option to provide 
a reason for cancelling. To continue signing the document, click Return to Signing. 

1 

 

2 

 

Signer name 
Number of documents to be signed 

Names of documents to be signed 
(Selected documents display in  
Preview Mode.) 
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3 The signer clicks Sign or Click here to sign for signatures, Initial or Initials for initials, 
and Review and/or Confirm Review for review confirmation. 
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4 The signature is displayed in the document. 
The signer clicks Next. The signing prompt moves to the next field. 
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5 The signer repeats steps 3 and 4 until all documents have been completely signed and 
reviewed. 
When the signer is done signing and reviewing all of the documents, the message “You 
have signed all documents. Click the Confirm Signatures and Finish button.” is displayed 
on the IMM eSign web browser.  
The signer clicks Confirm your Signatures or Confirm Signatures and Finish on the 
IMM eSign browser. 

 

6 You are returned to the eSignature Management page. Repeat this process as 
necessary until all of the documents have been signed by all of the signers. 
After all documents in the session have been signed/viewed by all parties in-person, click 
Delivery to send the documents securely to all of the signing/viewing parties. Refer to 
Secure Email Delivery on page 161 for more details. 

 
The Delivery button is only available if the parties are signing/viewing in-person. 

 
Click Continue to return to the Session Details page. 
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Draw 
In-person signing with the draw method is available for PCs, iPads, and ViewSonic and Wacom 
displays. If using Wacom or ViewSonic displays, you have the ability to slide the interface 
between monitors as needed when your monitors are set to extended display.  
This PC-touch capable feature gives signers as much control as your financial institution 
desires, such as the ability to create signatures, confirm intent to sign, and apply signatures, 
while you easily maintain control of the overall signing process from your own monitor. The 
procedure in this section applies to the party that is operating the IMM eSign web browser (the 
FI representative or the signer) during that particular step. 

 
Certain Wacom displays are supported. Use a Wacom display as an extended monitor to 
enhance the in-person document viewing and signing experience. Move the eSign 
browser back and forth between the operator’s primary monitor and the Wacom display by 
dragging and dropping the browser while in extended monitor mode. Alternatively, 
purchase a third-party tool for configuring keyboard shortcuts, such as UltraMon 
(https://www.realtimesoft.com/ultramon/), to move the eSign browser back and forth 
between the operator’s primary monitor and the Wacom display. Before use, confirm that 
the Wacom display is using the latest drivers found on the Wacom website: 
http://www.wacom.com/en-us/support/product-support/drivers. Wacom displays are not 
compatible with DisplayLink drivers. 
Refer to the following suggested model of how to use a Wacom display: 

 

 

 
Verify that the driver software that comes with the monitors is installed prior to using IMM 
eSign. 

 

https://www.realtimesoft.com/ultramon/
http://www.wacom.com/en-us/support/product-support/drivers
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This is a summary of how terms are reviewed, signatures and initials are created, signatures 
and initials are applied, and signatures/initials/review are confirmed: 

1. The FI representative reviews the Disclosure and Consent to the Use of Electronic 
Signatures and Records with the signer. 

 
It is recommended to give the signer control of the IMM eSign web 
browser to create and apply his or her signatures and initials. 

 
2. The signer draws his or her signature and initials in the Signature and Initials fields. 
3. The signer clicks Accept if the signer agrees to the Disclosure and Consent and Terms 

of Use.  
4. Once the signature and the initials are created, the first document that requires a 

signature or review confirmation is displayed on the IMM eSign web browser.  
5. The signer clicks Sign or Click Here to Sign (or Initial/Initials) to apply the signer’s 

signature or initials. The signer clicks Review and/or Confirm Review on the IMM eSign 
browser to confirm that he or she viewed the document. Once applied, the Next button 
appears.  

6. The signer clicks Next to move to the next field.  
7. The signer repeats steps 5 and 6 as necessary until the IMM eSign web browser 

displays “You have signed all documents.”  
8. The signer clicks Confirm your Signatures or Confirm Signatures and Finish. The 

signer is done. The IMM eSign web browser returns to the eSignature Management 
page. 

9. Repeat this process until all of the signers have signed all of the documents. 
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Refer to the following procedure for details on in-person signing using the draw method: 

1 After clicking Sign from the eSignature Management page, the Welcome page is displayed. 
The name and initials are automatically populated. The examples in this guide have both 
signatures and initials. 

 
 1 Review the Disclosure and Consent to the Use of Electronic Signatures and Records 

with the signer. You may print the disclosure and consent agreement by clicking the 
Print button, or simply read it by using the scroll bar. 

 2 Verify Draw is selected. 
  3    Direct the signer to draw a signature and initials. Click Clear to clear the signature or 

initials and sign or initial again. 
 4 Click Add Photo to add a photo of the Signer. Refer to Adding a Photo on page 

115 for more information. 
 

1 

 

2 

 

3 

 4 
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2 Direct the signer to click Accept to use the signature, initials, and/or photo.  

 
The signer clicks Decline to stop this transaction. The Declining Terms popup is 
displayed. Click Decline Terms to decline the terms and return to the eSignature 
Management page. Prior to clicking Decline Terms, you have the option to provide a 
reason for declining. To continue signing the document, click Return to Terms. 
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3 When the signature and initials have been accepted, the first document that requires 
signing/reviewing is displayed. 

 
Documents that require signatures or review confirmation are listed below the signer 
name. When a document is selected from the list, it will display in Preview mode. If a 
document is selected from the list, return to Signing mode by clicking the field in the 
document where the next signature is required. 
 1 Print Unsigned allows you to print a copy of this document without signatures. 
 2 Cancel exits signing. The Cancelling Document Signing popup is displayed. Click 

Cancel Signing to discontinue signing the document and to return to the eSignature 
Management page. Prior to clicking Cancel Signing, you have the option to provide 
a reason for cancelling. To continue signing the document, click Return to Signing. 

1 

 
2 

 

Signer name 
Number of documents to be signed/reviewed 

Names of documents to be signed 
(Selected documents display in  
Preview Mode.) 
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4 The signer clicks Sign or Click here to sign for signatures, Initial or Initials for initials, 
and Review and/or Confirm Review for review confirmation. 
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5 The signature is displayed in the document. The signer clicks Next. The signing prompt 
moves to the next field. 
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6 The signer repeats steps 4 and 5 until all documents have been completely signed and 
reviewed. 
When the signer is done signing and reviewing all of the documents, the message “You 
have signed all documents. Click the Confirm Signatures and Finish button.” is displayed 
on the IMM eSign web browser.  
The signer clicks Confirm your Signatures or Confirm Signatures and Finish on the 
IMM eSign browser. 

 

7 You are returned to the eSignature Management page. Repeat this process as 
necessary until all of the documents have been signed by all of the signers. 
After all documents in the session have been signed/viewed by all parties in-person, click 
Delivery to send the documents securely to all of the signing/viewing parties. Refer to 
Secure Email Delivery on page 161 for more details. 

 
The Delivery button is only available if the parties are signing/viewing in-person. 

 
Click Continue to return to the Session Details page. 
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Adding a Photo 
1 

 
Your workstation must have a camera attached and set up. 
When a photo is captured in the consent page, the photo will appear next to the 
signature throughout the document.  
No physical file outside of the application can be used.  
The picture automatically resizes in the document. 

 
To add a photo from the Welcome page, click the Add Photo button.  
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2 In the Capture Photo popup, select your 
camera from the dropdown menu if 
necessary and click Take to capture the 
photograph. 
Click Cancel to exit the Capture Photo 
popup. 

3 Once the photograph is captured, click 
Use Photo to use this image or click 
Retake to replace the photo with a new 
captured image.  
If you have chosen Retake, the photo box 
clears and is ready to capture a new photo 
to your satisfaction. 
 

1 
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4 The eSignature Management page refreshes with the photo in place of the Add Photo 
button.  

 
Click Clear to remove the picture. 
Once the photograph is captured, continue with the signing process as outlined in  
In-Person Signing on page 77. 
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In-Person Viewing 
Specific documents and attachments within a document set can be assigned to a party so that 
the party can view and approve them without the need for signatures or data entry.  
To initiate the in-person signing and viewing process on the eSignature Management page, the 
financial institution representative clicks Sign or Start:  
• When a party has documents to sign or when a party has documents to sign and documents 

to view, the Sign button is displayed. Refer to In-Person Signing for details. 

• When a party only has documents to view, the Start button is displayed. 

 
Signature Pad 

 
If your FI Administrator has disabled messages on the signature pad, follow the In-
Person Viewing procedure for the Type method of signing. 

 
This is a summary of how terms are reviewed and document review is confirmed: 

1. The FI representative reviews the Disclosure and Consent to the Use of Electronic 
Signatures and Records with the signer. 

2. The FI representative clicks Continue. The signature pad displays “I have reviewed the 
provided Disclosure and Consent and agree to the Terms of Use.” The signer selects 
Accept. 

3. The first document that requires review is displayed in the IMM eSign web browser. The 
signature pad does not display the documents. For the signer to see the documents, the 
signer must see the IMM eSign web browser. 

4. The signer selects Review when prompted by the signature pad to confirm that he or 
she viewed the document (e.g., “I reviewed DOCUMENTNAME.”). The signer is 
automatically moved to the next field. The signer continues to select Review on the 
signature pad until the document set is completely reviewed. 

 
If the IMM eSign web browser displays Review/Confirm Review buttons that 
you must click before the signer can confirm review on the signature pad, 
contact your administrator. Examples of the buttons are shown below. The 
recommended Signature Pad Administration eSignature settings are outlined 
in the financial institution administrator’s guide.  
The buttons are not displayed in this section because they are not 
recommended when using the signature pad with messages. When 
these buttons are disabled as recommended, 
additional unnecessary clicks are eliminated.  
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5. When the document set is complete, the signature pad displays “I confirm that I have 
reviewed the document set.” The signer selects Confirm Review. The signer is done. 
The IMM eSign web browser returns to the eSignature Management page. 

6. Repeat this self-guided process until all of the signers have signed all of the documents. 
Refer to the following procedure for details on in-person viewing with signature pads that display 
messages:  

1 After clicking Start from the eSignature Management page, the Welcome page is displayed.  

 
  1    Review the Disclosure and Consent to the Use of Electronic Signatures and Records 

with the signer. You may print the disclosure and consent agreement by clicking the 
Print button, or simply read it by using the scroll bar. 

 2 Select Signature Pad.  
 3 Click Continue to review the documents. 

Click Decline to stop this transaction. The Declining Terms popup is displayed. Click 
Decline Terms to decline the terms and return to the eSignature Management page. 
Prior to clicking Decline Terms, you have the option to provide a reason for 
declining. To continue signing the document, click Return to Terms. 

1 

 

2 

 

3 
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2 The signature pad displays “I have reviewed the provided Disclosure and Consent and 
agree to the Terms of Use.” 

 
Direct the signer to select either Accept or Decline on the signature pad: 

• The signer selects Accept to review the documents. 

• The signer selects Decline to stop this transaction. The Declining Terms popup is 
displayed on the IMM eSign web browser. As the FI representative, it is your 
responsibility to click Decline Terms to terminate the signing process and to return to 
the eSignature Management page. Prior to clicking Decline Terms, you have the 
option to provide a reason for cancelling. To continue the signing process, click Return 
to Terms. 
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3 When the Disclosure and Consent and agree to the Terms of Use have been accepted, 
the first document that requires a review is displayed on the IMM eSign web browser. 
Direct the signer’s attention to the signature pad. 

 
Documents that review confirmation is necessary are listed below the signer name. When 
a document is selected from the list, it will display in Preview mode. If a document is 
selected from the list, return to Signing mode by clicking the field in the document where 
the next signature is required. 
 1 The IMM eSign web browser automatically navigates to each field that requires a 

review confirmation. Before the signer applies the review confirmation using the 
signature pad, the field displayed in the IMM eSign web browser contains the 
message “Please wait.” Once the signer applies the review confirmation on the 
signature pad, the next review field is displayed in the IMM eSign web browser with 
the message “Please wait.” This continues until the process is complete. 

 2 Print Unsigned allows you to print a copy of this document without signatures. 
 3 Cancel exits signing. The Cancelling Document Signing popup is displayed on the 

IMM eSign web browser. As the FI representative, it is your responsibility to click 
Cancel Signing to terminate the signing process and to return to the eSignature 
Management page. Prior to clicking Cancel Signing, you have the option to provide 
a reason for cancelling. To continue the signing process, click Return to Signing. 

2 

 

3 

 

1 

 

Signer name 
Number of documents to be reviewed 

Names of documents to be signed 
(Selected documents display in  
Preview Mode.) 



IMM eSign 2018.1  
User/Document Administrator Guide  

122 Copyright © 2019 IMM Rev. 2/27/19 

4 For review confirmation, the signature pad displays “I reviewed DOCUMENTNAME.” 

 
Direct the signer to select Review or Cancel on the signature pad: 

• The signer selects Review to confirm review.  

• The signer selects Cancel to exit signing. The Cancelling Document Signing popup is 
displayed on the IMM eSign web browser. As the FI representative, it is your 
responsibility to click Cancel Signing to terminate the signing process and to return to 
the eSignature Management page. Prior to clicking Cancel Signing, you have the 
option to provide a reason for cancelling. To continue the signing process, click Return 
to Signing. 

The signer continues to confirm review using the signature pad until all of the documents 
have been signed. 
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5 When the signer is done signing all of the documents, the message “You have reviewed 
all documents. Click the Confirm Review and Finish button.” is displayed on the IMM 
eSign web browser.  
Direct the signer’s attention to the signature pad. 
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6 The signature pad displays “I confirm that I reviewed the DOCUMENTNAME document 
set.” 

 
Direct the signer to select Confirm Review or Cancel on the signature pad: 

• The signer selects Confirm Review to confirm that he or she viewed the documents.  

• The signer selects Cancel to exit signing. The Cancelling Document Signing popup is 
displayed on the IMM eSign web browser. As the FI representative, it is your 
responsibility to click Cancel Signing to terminate the signing process and to return to 
the eSignature Management page. Prior to clicking Cancel Signing, you have the 
option to provide a reason for cancelling. To continue the signing process, click Return 
to Signing. 

7 You are returned to the eSignature Management page. Repeat this process as 
necessary until all of the documents have been reviewed by all of the signers. 
After all documents in the session have been signed/viewed by all parties in-person, click 
Delivery to send the documents securely to all of the signing/viewing parties. Refer to 
Secure Email Delivery on page 161 for more details. 

 
The Delivery button is only available if the parties are signing/viewing in-person. 

 
Click Continue to return to the Session Details page. 
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Type 
This is a summary of how terms are reviewed and document review is confirmed: 

1. The FI representative reviews the Disclosure and Consent to the Use of Electronic 
Signatures and Records with the signer. 

2. If the signer approves the Disclosure and Consent to the Use of Electronic Signatures 
and Records, the FI representative clicks Accept.  

3. The first document that requires a review confirmation is displayed on the IMM eSign 
web browser. 

 
It is recommended to give the signer control of the IMM eSign web 
browser to review documents. 

4. The signer clicks the Review arrow to navigate to the bottom of the document and then 
clicks Confirm Review to confirm that he or she viewed the document. If there are 
multiple documents to review, the signer is moved to the next field.  

5. The signer repeats step 4 as necessary until the IMM eSign web browser displays “You 
have reviewed all documents. Click the Confirm Review and Finish button.”  

6. The signer clicks Confirm completion or Confirm Review and Finish. The signer is 
done. The IMM eSign web browser returns to the eSignature Management page. 

7. Repeat this process until all of the signers have reviewed all of the documents. 
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Refer to the following procedure for details on in-person viewing using the type method: 

1 After clicking Start from the eSignature Management page, the Welcome page is displayed.  

 
 1 Review the Disclosure and Consent to the Use of Electronic Signatures and Records 

with the signer. You may print the disclosure and consent agreement by clicking the 
Print button, or simply read it by using the scroll bar. 

 2 Select Type. When Type is the default signing method (as set by the Administrator), 
the Type button is preselected. 

 3 Click Accept to review the documents. 
Click Decline to stop this transaction. The Declining Terms popup is displayed. Click 
Decline Terms to decline the terms and return to the eSignature Management page. 
Prior to clicking Decline Terms, you have the option to provide a reason for 
declining. To continue signing the document, click Return to Terms. 

1 

 

2 

 

3 
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2 The signer clicks Review to navigate to the bottom of the document that he or she has 
reviewed.  

 

Signer name 
Number of documents to be reviewed 

Names of documents to be signed 
(Selected documents display in  
Preview Mode.) 
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3 The signer clicks Confirm Review for review confirmation of the document. 
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4 The signer repeats steps 2 and 3 until all documents have been completely reviewed. 
When the signer is done reviewing all of the documents, the message “You have 
reviewed all documents. Click the Confirm Review and Finish button.” is displayed on the 
IMM eSign web browser.  
The signer clicks Confirm completion or Confirm Review and Finish on the IMM eSign 
browser. 

 

5 You are returned to the eSignature Management page. Repeat this process as 
necessary until all of the documents have been reviewed by all of the signers. 
After all documents in the session have been signed/viewed by all parties in-person, click 
Delivery to send the documents securely to all of the signing/viewing parties. Refer to 
Secure Email Delivery on page 161 for more details. 

 
The Delivery button is only available if the parties are signing/viewing in-person. 

 
Click Continue to return to the Session Details page. 
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Remote Signing 
1 Sign remotely from the eSignature Management page as follows. Refer to eSignature 

Management on page 158 for an overview of the eSignature Management page and the 
specific remote signing options. 

 
 1 Click one of the remote signing options: Email Authentication, Password 

Authentication, KBA, or Phone Authentication.  
 2 When you click a remote signing option, fields appear below the signing option. The 

visible fields depend on the remote signing option selected. Refer to eSignature 
Management on page 158 for more information. 

 3 The Message Details section automatically appears at the bottom of the eSignature 
page. 

1 

 

2 

 

3 
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2 Fill in the information in the Message Details section. 

 
 1 Sender: Click the drop-down menu to add or change the email address in the 

Sender field. (Default: Your email address)  
 2 CC: The carbon copy (CC) field appears after the Sender field is filled. Click the 

drop-down menu to add one or more FI employee emails. The selected FI 
employees are carbon copied on the email.  

 3 Subject: The Subject field is prefilled with the name of the signer of the document 
set. The content can be changed as needed. 

 4 Message: Fill in the Message field. Use the default message that is displayed or 
change as desired. 

 5 Click Send. All in-person signatures and review confirmations must be complete for 
the Send button to be enabled. 

3 The eSignature Management page refreshes. The “Session is successfully submitted for 
Remote Signatures” message is displayed. 

1 

 

2 

 

3 

 

4 

 
5 
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4 The signing parties receive emails similar to this: 

 
The signer clicks the link in the email Click here to review and sign Document Set (for 
John Smith). 
For password authentication, KBA, and phone authentication, the signer is prompted to 
enter information. Once authorization is complete, the signer must consent to do business 
electronically. 

Party 1 Email 

Message 

Attachments 

Party 2 Email 

Available until 

Subject 
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Then, the signer will then be prompted for each signature, initial, and review confirmation 
required throughout the signing process. Documents can be viewed and printed. 

Transferring a Session 
Transfer a session from the Search Active Sessions page or the Session Details page.  

• If transferring a session from the Search Active Sessions page, you can transfer multiple 
sessions at once. Refer to Search Active Sessions Search Results for more information on 
entering Transfer mode and selecting sessions to transfer. 

• If transferring a session from the Session Details page, refer to Session Details for more 
information on the Transfer button. 

To transfer session ownership from one user to another, do the following: 
1. Once the session(s) is selected on the Search Active Sessions page or the Session Details 

page, click Transfer. The Transfer Session popup is displayed. 

 
2. To continue, select a user from the Transfer all selected records to drop-down list. 
3. Click Transfer to continue or Cancel to cancel the session transfer and return to the Search 

Active Sessions page or Session Details page. Once Transfer is clicked, the selected 
session is transferred to the new session owner. If the session was transferred from the 
Search Active Sessions page, the page reloads and displays the new owner in the session 
information. If the session was transferred from the Session Details page, the page reloads, 
the buttons are disabled, and the message “Session successfully transferred” is displayed. 
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Unlocking a Session 
Unlock a session from the Search Active Sessions page. Refer to Search Active on page 144 
for more information on the features and functions of the Search Active Sessions page. 
To unlock a selected session, do the following: 

1. On the Search Active Sessions page, click the Unlock  icon next to the session that you 
would like to delete. The Unlock Session popup is displayed.  

 
2. To continue, click Unlock to unlock the session. The selected session is unlocked and the 

Search Active Sessions page is refreshed. Click Cancel to return to the Search Active 
Sessions page. 

Deleting a Session 
This setting is controlled by the Administrator. Delete one or more sessions from the Search 
Active Sessions page. Signed sessions cannot be deleted. Refer to Search Active on page 144 
for more information on entering Delete mode and selecting the sessions to delete. 
To delete one or more sessions, do the following: 
1. Once the session(s) is selected on the Search Active Sessions page, click Delete. The 

Delete Session popup is displayed. 
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2. To continue, click Delete to delete the session(s). The selected session is deleted and the 
Search Active Sessions page is refreshed. Click Cancel to return to the Search Active 
Sessions page.  

Archiving Documents 
This feature allows you to archive documents that have been completed in full, including all 
required signatures. The Archive button remains disabled until all signatures have been 
secured. An archived document is flattened and cannot be modified. 
To archive all of the documents in the document set, click Archive on the Session Details page. 
Once the document set is archived, the message “Session Archived Successfully” is displayed 
at the top of the page and all buttons are disabled. 

 

 
If the indexing message displays “0 of x archived document(s) indexed successfully,” 
contact your FI Administrator.  
Since this document set has been archived, there should be no changes to index 
fields. 



IMM eSign 2018.1  
User/Document Administrator Guide  

136 Copyright © 2019 IMM Rev. 2/27/19 

To archive individual documents (RTS only), click the Archive  icon for the particular 
document. Once the document is archived, the document is removed from the set and “Archived 
document successfully” is displayed at the top of the page. 
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IMM eSign Menus 

 
Using IMM eSign on a tablet requires the use of a tablet-specific stylus. 

 
After you log in, the Search Active Sessions page is displayed. Your company logo, menu 
choices and your user name display in the menu bar.  

   
The following sections describe the available menu options along with brief descriptions of 
their functionality. 
Processing 
Reporting 
Help 
User Name 
Logout 

Processing 
The Processing menu includes the following options, which are described in detail in this section 
of the guide. 
Create New Session (XML Only) 
Search Active 
Search Completed 
Cases (eSign plus) 
Loan Coupons 
Starter Checks  
Custom Links 
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Create New Session (XML Only) 
Click Processing > Create New Session to access the New Session page. The New Session 
page allows users to create an XML session directly in IMM eSign.  
Alternatively, when data is passed from the core/host system, a variation of the New Session 
page is automatically launched in IMM eSign.  
To use the New Session page, refer to Creating a New Session (XML Only) on page 14.  
The Page Help button provides a quick listing of icons and functions available and related to the 
New Session page. 
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Once you have entered the appropriate information, the New Session page is displayed as 
shown in the following example.  

 
1 Preview: Click Preview to view all of the selected documents in a PDF popup window. 
2 Process: Once you are done adding and deleting the documents for the session, click 

Process. Refer to Processing Documents for details about processing the documents. 
After you process the documents, you can still add documents to the session using the 
Add Docs button on the Session Details page. Refer to Adding Documents for details. 

3 Add Documents: When creating a new session from the Processing > Create New 
Session menu, add documents and documents sets from the library. Refer to Adding 
Documents for details about the Add Documents area.  

3 

5 
 

4 
 

6 
 

1 2 

7 
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When the New Session page is automatically launched in IMM eSign after data is passed 
from the core/host system, the Add Documents area does not contain the Platform field. 
Instead, the Add Documents area contains the Library, Attach, Scan, and Photo tabs as 
shown below. In IMM eSign plus integrations, only the Library tab is available. Refer to 
Adding and Deleting Documents for a New Session on page 14 for details about using 
the New Session page when it is launched after data is passed from the core/host system. 

 
4 Selected Documents: The documents that are added to the session are displayed in this 

area.  
5 Indexes: When creating a new session from Processing > Create New Session, there 

are no indexes because the documents have not been processed yet. When data is 
passed from the core/host system, the index data is displayed here. 

6 Documents Library or Document Sets Library: When Documents is selected in the Add 
Documents area, the Documents Library is displayed. When Sets is selected in the Add 
Documents area, the Document Sets Library is displayed. Click the title row to expand and 
collapse the available documents. 

7 Document Indicators:  

• Single Document : The document is a single document and is not associated with 
a group of documents. 

• Document is part of set : The document is a part of a group of documents. 

• Number of Documents : The number indicates the amount of documents in a 
group. (Only applicable to the Document Sets Library) 
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Library 
The Documents Library and Document Sets Library lists the available documents. Collapse or 
expand the Documents Library and Document Sets Library by clicking on the title row. 
Documents Library 
If Documents is selected in the Add Documents area, the Documents Library is displayed. To 
select documents, click Select Document  next to the desired documents. 

 
Document Sets Library 
If Sets is selected in the Add Documents area, the Document Sets Library is displayed.  
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To select all of the documents in a document set, click Select Document Set  . To select 
specific documents in a document set, click the document set row to expand it. Then, click 
Select Document  next to the desired documents. 

 
If a document set or part of a document set is added to the Selected Documents area, the 
Select Document Set  icon for that document set is not shown. Similarly, if a single 
document that is part of a document set is added to the Select Documents area, the Select 
Document  icon for that document is not shown. 
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Selected Documents 
When documents are added to the session, the Selected Documents area is displayed.  

 
1 Name of Document Set: If a document set or documents that are part of a document set 

are added to the Selected Documents area, the name of the associated document set is 
displayed here. 

2 Unselect All / Select All: When there are four or more documents, the Unselect All 
button appears. Click the button to toggle between Unselect All and Select All. When 
Unselect All is clicked, all of the documents that were checked become unchecked. When 
Select All is clicked, all of the documents that were unchecked become checked. 

3 Delete: Click Delete to remove selected documents from the list. 

4 : When the checkbox next to a document is checked, clicking Delete will remove that 
document from the Selected Documents area. When the checkbox next to a document is 
unchecked, clicking Delete will have no effect on that document. 

5 Preview: Click the Preview  icon to view a single document in a PDF popup window. 
From this window, you can view and print documents. Documents cannot be edited in 
Preview Mode. Refer to Previewing and Printing Documents on page 24 for more 
information. 

6 Display: Click the icon to toggle the display state of the document. When display is turned 

on, the Display  icon is shown and the document is displayed in PDF format while 

processing. If display is turned off, the Do Not Display  icon is shown and the 
document will not display during processing. This setting is controlled by the Administrator. 
The default state of this icon is determined when the document is defined. 

7 Archive: Documents that can be archived have an Archive  icon. The Archive icon 
will not display if a document has an unsigned signature field. If the Archive icon is clicked, 
the document will be archived. Refer to Archiving Documents on page 135 for details. 

1 

2 
3 

4 

5 6 7 8 
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8 Delete: Click the Delete  icon to the right of the document name to delete the document 
from the session.  

Search Active  
The Search Active Sessions page allows users to retrieve active sessions that have previously 
been saved. Search Active Sessions on the PC allows you to retrieve active sessions for 
processing, signing and archiving. On the iPad, sessions can be viewed and signed. 
Saved sessions are retained for 90 days (default) before they expire. Your settings may vary as 
they are set by your Administrator. 
From the Search Active Sessions page, FI representatives can access the Session Details 
page. 
To open the Search Active Sessions page, click Processing > Search Active. 
The Page Help button provides a quick listing of icons and functions available and related to the 
Search Active Sessions page. 
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To search for active sessions, do the following: 
1 Enter the search parameters. Refer to 

Common Routines on page 187 for 
more information. Search all active 
sessions by leaving all search parameters 
blank. Up to 150 sessions will display. 

2 Select Display Signed Sessions Only if 
you would like to only display sessions 
that are signed in the search results. 

3 After selecting or entering search 
parameters, click Search to display 
sessions matching the search 
parameters, or click Clear to reset the 
search parameters and clear any existing 
results.  

 
 
 

 

3
 
 
  

 

1
 
 
  

 

2
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After clicking Search, the Search Active Sessions page refreshes listing the search results.  

 
 1 Click the Open Session Details icon for any unlocked session to open the Session Details 

page for that session. 
 2 The Open Session Details icon will not display for locked sessions. 

1
 
  

 

2
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Clicking on session rows will expand that session for additional details.  
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Search Panel 

 1 Pin Search Panel: Clicking in the pin will display  or 

collapse  the search parameters section of the page 
when the results are displayed. 

 2 Platform: Search through all available platforms, or click 
the dropdown to select a single platform to search.  

 3 Date Range: Click the field to display a calendar and 
adjust the date range as desired. 

 4 Index Fields Region: Enter any additional search criteria 
in the available fields to narrow the search. The search 
fields displayed are controlled by the administrator. 

 5 Users: Click the field to search for documents belonging 
to one or more specific users. Choose from the dropdown 
list. Leave the field blank to search for documents owned 
by all users. Click outside the field to close the dropdown 
menu. The display of this field is controlled by the 
administrator.  

 6 Advanced Search: Click the Advanced Search button to 
reveal additional search index fields. 

 7 Display Signed Sessions Only: Click the checkbox to 
display only sessions that have been signed. 

 8 Action Buttons:  
 Click Search to continue.  
 Click Clear to reset the search parameters.  

 
 
 

1
 
  

 

2
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Search Results 

 
 1 Select All/Unselect All: Click Select All to select all unlocked sessions in the results list 

and place a check by the selected sessions. Click Unselect All to deselect all selected 
sessions in the results list.  

 2 Delete/Transfer Mode: Click Delete or Transfer to toggle all related icons and buttons 
from Delete to Transfer and vice versa. 

 3 Delete/Transfer: This button changes state when the Delete/Transfer Mode buttons (2) 

are toggled. Clicking Delete  removes any selected sessions. Clicking Transfer 
 changes session ownership of any selected sessions to another user. Refer to 

Transferring a Session for more details on changing session ownership. 
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 4 Sort By: Click the Sort By button to choose the order in which the search results will 
appear (Date Modified Ascending, Date Modified Descending, Name Ascending, Name 
Descending). 

 5 Click the Lock icon   to unlock a locked session. Clicking this icon will display the Unlock 
Session popup, which will provide who locked the session, when it was locked, and the 
sessionID. The ability to unlock a session is controlled by the Administrator. 

 
Sessions automatically lock when opened for user activity and become unlocked when 
a user completes all activity for that session and closes the session or logs out. 
Sessions may remain locked unexpectedly if the user does not complete the session 
and closes the browser. To prevent a session from remaining locked, the user should 
logout after all session-related activity is completed. 

 
 6 Selection Checkbox: Click to check or uncheck (select or deselect) the session to be 

transferred or deleted. 

 7 Session Transfer/Delete Icon (  / ): Click the Transfer  icon to transfer the 

session to another owner. Click to Delete  icon to delete a single document. 
 8 Session Details Region: The name of the first document in the session is displayed. This 

region summarizes the session details with Session name, Platform, Number of Days Left 
until expiration, Date and time last modified and the number of documents in the session. 

 9 Index Fields Region: This section provides the index information for the session. The 
fields names displayed vary by installation. 

 10 Open Session Details: Click this icon to go to the Session Details page for the selected 
session. Refer to Session Details for detailed information. 

 11    Documents, Signature Status, and Notes Tabs: Click on a tab to view the 
corresponding information:  
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• Documents Tab: Click to view a list of the documents for the selected session. Refer 
to the Session Details section for details about the features and functions of the page. 

 
• Signature Status Tab: Click to display details about the signature status of the 

documents. 

 
• Notes Tab: Click in the Notes field to add information relative to the document, user, 

or transaction. There can be several notes added. Notes travel with the session until 
the session is archived. Notes are retained with the session but will not be archived 
with the document set. Click Save to add the note to the session. Click Cancel to 
delete the contents in the Notes field. 
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Session Details  
When the documents are loaded to IMM eSign or when an active session is opened, the 
Sessions Details page is displayed. The user can perform the tasks associated with the session 
on this page.  
The Page Help button provides a quick listing of icons and functions available and related to the 
Session Details page. 
 

  
 
 
 
 
 
 
The default Session Details page can be displayed with the document indexes expanded or 
minimized. This view is determined by your Administrator. Click on a row to expand or minimize 
the view. 

Expanded Sessions Minimized Sessions 

 

 

 

 
The Session Details page will vary depending on your integration. 
For IMM eSign plus integrations, the routing information is displayed on the page.  
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If you click the History icon, a popup is displayed with the Comments, History, and 
Details tabs. 

 

 
 
1 Session Controls: Use the session control buttons to perform actions related to the 

session. Use the   arrows to display additional buttons.  

• Design: Click this button to access the Document Designer page. For details on getting 
started with the Document Designer page, refer to Using Document Designer on page 
26. For details on the Document Designer page controls, refer to Document Designer 
on page 155. The Design button is disabled after document session ownership has been 
transferred. 

 
Prosign documents may have unmapped fields and must be processed using 
Document Designer before being submitted for remote signatures. 

 

 
This feature is not available for iPad users. 

6 

 

1 

 

2 

 
3 

 

4 

 
5 

 
7 

 

9 

 
10 

 

8 

 

11 

 



IMM eSign 2018.1  
User/Document Administrator Guide  

154 Copyright © 2019 IMM Rev. 2/27/19 

• Process: Click this button to process documents. This button will be disabled if 
document session ownership has been transferred. The Process button will not be 
enabled if no documents are marked for display. Refer to Processing on page 137 for 
more information. 

 
This feature is not available for iPad users. 

• Route: This button is available for IMM eSign plus integrations. Click this button to route 
the session. Refer to Routing Documents on page 74 for details. 

• Sign: Click this button to go to the eSignature Management page to begin signing 
documents in person or remotely. Refer to eSignature Management on page 158 for 
more information. 

 
When unmapped or optional fields are detected, you are rerouted to the 
Document Designer page instead of the eSignature Management page.  

• Add Docs: Click this button to attach external documents, scanned items, and 
photographs to this session. Refer to Adding Documents on page 60 for more 
information. 

• Archive: Click this button to archive the session. Archive finalizes the session for use by 
your imaging system for permanent storage. No additional changes are allowed after the 
session is archived. The Archive button will be enabled if all documents within the 
session have been signed or if no documents in the session have signature fields. Refer 
to Archiving Documents on page 135 for more information. 

• Fill: Click this button to populate missing index information with information from other 
documents in the document set. If the field is not populated anywhere, clicking Fill will 
not correct the missing information.  

• Transfer: Click the Transfer button to Transfer session ownership from one user to 
another user. Refer to Transferring a Session on page 133 for details. 

2 Reorder: Drag and drop the Reorder  icon to change a document’s order in the 
document set. 

3 Document Name and Document Description: The name and description of the document 
in the document set. Click on the row to view the indexes associated with the document. 

4 Preview: Click the Preview  icon to view a single document in a PDF popup window. 
From this window, you can view and print documents. Documents cannot be edited in 
Preview Mode. Click the icon for the Document Set to view all the documents in the set in a 
PDF popup window. Click the preview icon next to Session Audit to view the audit 
information for the session. Refer to Previewing and Printing Documents on page 24 for 
more information. 

5 Display: Click the icon to toggle the display state of the document. When display is turned 

on, the Display  icon is shown and the document is displayed in PDF format while 

processing. If display is turned off, the Do Not Display  icon is shown and the 
document will not display during processing. This setting is controlled by the Administrator. 
The default state of this icon is determined when the document is defined. 
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On the Session Details page, the Display icon is now available for attachments 
with fillable data fields. During document processing, attached documents with 
fillable data fields are automatically displayed. Users can adjust the display 
settings by clicking the Display icon. Administrators cannot control if 
attachments are displayed; however, the Retrieved Session Default 
administrative setting will apply to attached documents with fillable data fields. If 
the Preserve Original Selection administrative setting is selected, the user’s 
preference for the display of attachments is remembered. 

6 Archive: Documents that can be archived have an Archive  icon. The Archive icon 
will not display if a document has an unsigned signature field. If the Archive icon is clicked, 
the document will be archived. Refer to Archiving Documents on page 135 for details. 

7 Delete: Click the Delete icon to the right of the document name to delete the document 
from the session. At least one document must remain in the list. Attachments can be 
removed. See Deleting a Session on page 134 for detailed information.   

8 Document Index Fields: When the document is expanded, the document index 
information is displayed. 

9 Session Audit: Click the Preview icon to display the Session Audit. This report lists all 
activities that take place during a session. This report will be archived along with the 
documents. Click the preview icon next to Session Audit to view the audit information for 
the session. 

10 Document Set: Preview all of the documents in the document set in one file. 
11 Notes: Click in the Notes field to add information relative to the document, user, or 

transaction. There can be several notes added. Notes travel with the session until the 
session is archived. Notes are retained with the session but will not be archived with the 
document set. Click Save to add the note to the session. Click Cancel to delete the 
contents in the Notes field. 

Document Designer 

 
This feature is not available for iPad users. 

 
The Document Designer page allows you to assign a template to unknown documents, map 
unmapped fields, and set optional fields as required or not. You can add, edit or delete 
signature fields, signature date fields, initial fields, textboxes, checkboxes, and dropdown lists. 
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In addition, this page can also be used to add, edit or delete signer (party) information. 
Attachments can be requested from remote parties from this page as well.  
You can access the Document Designer from the Session Details page or eSignature 
Management page. 

 
Signed documents cannot be modified. 

 

 

When templates must be assigned, fields are unmapped, or fields are optional, the 
Document Designer page is displayed in different modes. Refer to Using Document 
Designer on page 26 for more information. 

 

 
 1 Action Buttons:  

 Continue: The Continue button is only enabled when all Signature and Initial fields in all 
documents in the current session are mapped to Signers and any 
Textbox/Checkbox/Dropdown fields are mapped with a Role/Type.  

 Cancel: The Cancel button will return you to the page from where the Document 
Designer was accessed. 

2 Review Assignments / Manage Unmapped Fields / Review Optional: When Review 
Assignments is displayed, click it to review the party that is assigned to each field (RTS). 
When Manage Unmapped Fields is displayed, you are in Manage Unmapped Fields 
mode (XML). When Review Optional is displayed, click it to review optional signatures 
and fields (XML). Refer to Using Document Designer on page 26 for more information. 

3 Add Signer: Add a new signer. 
4 Request Attachments: Click to add accompanying documents that may be required for a 

signer who is signing remotely. This button will be enabled only when at least one signer is 
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selected for remote signature. Refer to Requesting Attachments on page 51 for detailed 
information about adding Remote Attachments. 

 5 Signers: Lists all known signers and their email addresses (if available) and lists the 
number of documents for each signer. Double click on a signer’s name to modify the signer 
name or email.  

 Click the document icon  to view documents associated with the selected signer. Refer 
to Adding, Editing, and Removing Signers on page 37 for detailed information on 
adding, editing and deleting signers. 

 6 Documents: Lists all documents currently in the session with the number of signatures or 
initials for each document. Click the people icon  to view the signers associated with the 
selected document. Attachments will display and Signature/Initial fields can be added to 
these attachments. 
 Documents not associated with a signer display with a yellow background.  
 Signers not associated with a document display with a yellow background.  
 When a signer is selected while modifying a document, documents associated with that 

signer will display with a green background.  
 7 Document name and navigation buttons: Displays the name of the document currently 

being reviewed. Navigation buttons allow moving between the documents in the session. 
 8 Field buttons: Click and drag these fields into a document. You can then associate a 

signer, role or type with the field.  

 
Colors defined in this area are used in the Blue theme and will change when 
other themes are used. 
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eSignature Management 
After clicking Sign on the Session Details page, the eSignature Management page is displayed.  
The Page Help button provides a quick listing of icons and functions available and related to the 
eSignature Management page. 
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The eSignature Management page displays a list of signers as well as the signing/viewing 
method. Remote signing is only available if the Remote Signatures add-on is enabled. 

 
1 Design: Click this button to access the Document Designer page. For details on getting 

started with the Document Designer page, refer to Using Document Designer. For details 
on the Document Designer page controls, refer to Document Designer. The Design button 
is disabled after document session ownership has been transferred. 

 
This feature is not available for iPad users. 

2 Request Attachments: Supporting documents such as pay stubs, W2s, Driver License, 
Passport, etc. can be requested as required from a remote signer by using the Request 
Attachments option. This option is for Remote Signatures only. The button is disabled until 
a remote signing option is selected. Refer to Requesting Attachments on page 44 for 
detailed information about adding remote attachments. 

3 Back: Click Back to return to the Session Details page. 
4 Merge: Click to merge two or more signers. This button will not be displayed if there is only 

one signer. Refer to Merging Signers on page 76 for more information. 
5 Number of Documents: The icon displays the number of documents in the document set 

that are assigned to the signer.  
6 Party Name: The name of the person who will sign and/or view the document(s). 
7 View the Document Set: When a party’s row is clicked, the row expands to display the 

documents in the document set. Click the row again to hide the document list. The 

documents that have the Sign icon displayed next to them are documents that the 
party must sign. Depending on the settings configured by your Administrator, you can 

4 

2 

 
3 

 
5 

 
6 

 
8 

 
9 

 10 

 
7 

 

11 

 

1 

 



IMM eSign 2018.1  
User/Document Administrator Guide  

160 Copyright © 2019 IMM Rev. 2/27/19 

perform the following actions before the signer/viewer completes the signing/viewing 
process: 

• Preview: Click the Preview  icon to view a single document in a PDF popup 
window. From this window, you can view and print documents. Documents cannot 
be edited in Preview mode. 

• View: Click the icon to toggle the view state of the document. When the View  
icon is displayed next to a document, the party must view the document during the 
signing/viewing process and confirm that he or she reviewed the document. When 

the No View  icon is displayed next to a document, the party will not view the 
document during the signing/viewing process. The default state of this icon is 
determined when the document is defined. 

 
The No View  icon may not be displayed. This setting is controlled by 
your administrator. 

 
8 Print: Click to print the documents. 

9 Sign In Person: When the Sign In Person  button is clicked, the documents 
will be signed/viewed in person.  

10 Sign Remotely: When one of the remote authentication methods are selected, documents 
will be signed remotely. 

11 Done: The green check mark  indicates that the party has completed the 
signing/viewing process.  

Sign In Person 

When the Sign In Person  button is clicked, the documents will be signed/viewed in 
person.  

 
To initiate the in-person signing and viewing process on the eSignature Management page, the 
financial institution representative clicks Sign or Start:  
• When a party has documents to sign or when a party has documents to sign and documents 

to view, the Sign  button is displayed. Refer to In-Person Signing for details. 

• When a party only has documents to view, the Start  button is displayed. Refer to 
In-Person Viewing for details. 
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Secure Email Delivery 
After the documents are signed and/or viewed in person, the eSignature Management page is 
updated. The Delivery button is displayed. 
To send the documents for secure remote delivery, perform the following procedure. 

1 On the eSignature Management page, click Delivery. 

 

2 Make changes as necessary. Refer to the Sign Remotely section on page 162 for details 
about the page. 

 

3 When finished, click Send. The page refreshes and displays the following message. 

 

 



IMM eSign 2018.1  
User/Document Administrator Guide  

162 Copyright © 2019 IMM Rev. 2/27/19 

Sign Remotely 
When a remote authentication method is selected (Email Authentication, Password 
Authentication, KBA, or Phone Authentication), the documents will be signed/viewed remotely.  

 

If the email address that is entered in the Email Authentication, Password 
Authentication, KBA, or Phone Authentication fields is already registered with Adobe, 
the party’s name that was used to register the email address is displayed during the 
signing process regardless of the name entered in IMM eSign. 
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1 Email Authentication: The party will receive an email notification. They are instructed to 

click the “Click here to review and eSign” link to gain access to the documents for signing. 
2 Password Authentication: The party will receive an email notification. They are instructed 

to click the “Click here to review and eSign” link. The party is then prompted to enter the 
Shared Secret Password to gain access to the documents for signing. The password must 
be at least 8 characters and a mix of lower and upper case letters and numbers. 

3 KBA: The party will receive an email notification.  They are instructed to click the “Click 
here to review and eSign” link. The party is prompted to enter identity information and 
answer arbitrary public record questions pertaining to his or her identity. The party’s credit 
history/report is not accessed or impacted when using the KBA authentication service. 

4 Phone Authentication: The party will receive an email notification.  They are instructed to 
click the “Click here to review and eSign” link. The party is prompted to select the 
Verification Option (Voice Call or Text Message). A Verification Code will be delivered to 
the Verification Option method the party selected.  The party will enter the Verification 
Code in the Code field and click OK to gain access to the documents for signing. 

5 Sender: Click the drop-down menu to add or change the email address in the Sender field. 
(Default: Your email address)  

6 CC: The carbon copy (CC) field appears after the Sender field is filled. Click the drop-down 
menu to add one or more FI employee emails. The selected FI employees are carbon 
copied on the email.  

7 Subject: The Subject field is prefilled with the name of the signer of the document set. The 
content can be changed as needed. 

8 Message: Fill in the Message field. Use the default message that is displayed or change 
as desired. 

9 Send: The Send button initiates the remote signing process. All in-person signatures and 
review confirmations must be complete for the Send button to be enabled. 
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Search Completed 
The Search Completed Sessions page allows you to access completed sessions. To open the 
Search Completed Sessions page, click Processing > Search Completed. 
The Page Help button provides a quick listing of icons and functions available and related to the 
Search Completed Sessions page. 
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To search completed sessions, perform the following procedure: 
1. Click Processing > Search Completed. The Search Completed Sessions page is 

displayed.  
2. Enter search parameters: 

 1 Pin Search Panel: Clicking in the pin will display  or 

collapse  the search parameters section of the page 
when the results are displayed. 

 2 Platform: Search through all available platforms, or click 
the dropdown to select a single platform to search.  

 3 Date Range: Click the field to display a calendar and 
adjust the date range as desired. 

 4 Index Fields Region: Enter any additional search criteria 
in the available fields to narrow the search. The search 
fields displayed are controlled by the administrator. 

 5 Users: Click the field to search for documents belonging 
to one or more specific users. Choose from the dropdown 
list. Leave the field blank to search for documents owned 
by all users. Click outside the field to close the dropdown 
menu. The display of this field is controlled by the 
administrator.  

 6 Advanced Search: Click the Advanced Search button to 
reveal additional search index fields. 

 7 Indexing: Select Indexed if you would like to display 
sessions that have been indexed, select Not Indexed to 
display sessions that have not been indexed, or select All 
to display sessions both indexed and not indexed. 

 8 Action Buttons:  
 Click Search to continue.  
 Click Clear to reset the search parameters.  

3. Click Search. The Search Completed Sessions page refreshes with the results for the 
information requested in the Search Archived Documents. 

 
This page lists all documents in the Archive folder that meet the specified criteria. 
If your imaging system has already moved the documents, they will not be listed here. 

This list can be sorted by clicking on Column Titles. Subsequent clicks alternate between 
ascending and descending order. 

4. Click Clear to clear the search results and search parameters. 
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Cases (eSign plus) 
Click Processing > Cases to access the Cases page. The Cases page is available for IMM 
eSign plus integrations only. This page contains a list of tasks that a user needs to complete. 
Click any of the cases in the list to expand the information for that case. 
The Page Help button provides a quick listing of icons and functions available and related to the 
New Session page. 
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Search Panel 

 1 Pin Search Panel: Clicking in the pin will display  or 

collapse  the search parameters section of the page 
when the results are displayed. 

 2 Date Range: Click the field to display a calendar and 
adjust the date range as desired. 

 3 Index Fields Region: Enter any additional search 
criteria in the available fields to narrow the search. The 
search fields displayed are controlled by the 
administrator. 

 4 Advanced Search: Click the Advanced Search button 
to reveal additional search index fields. If filtering by the 
Advanced Search Workflow option, the Re-Route button 
is displayed on the search results page. Select the 
desired cases and click Re-Route to reroute multiple 
cases at once. 

 5 Status Based Filters: Filters or displays the cases by status: My Cases, Active, 
Completed, or Cancelled.  

 6 Action Buttons:  
 Click Search to continue.  
 Click Clear to reset the search parameters.  
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Search Results 

 
1 Search: Click to pin or unpin the search panel. Refer to Search Panel on page 167 for 

more information.  
2 Sort By: Click to toggle the sort order to Title Field ASC (ascending order), Title Field DES 

(descending order), Date Received ASC (ascending order), or Date Received DES 
(descending order).  

3 Lock: When this icon is visible, the session is locked by another user. The session can be 
unlocked by your administrator. 

4 Important: When this icon is visible, the session is marked as important. 
5 Workflow Case Information: Provides Title Field, Document Set, From, Inbox, Step, 

Workflow name, Received, and Platform. When the row is clicked, it displays additional 
information about the workflow case. 

6 Open Session: When this icon is clicked, you are routed to the Session Details page. 
7 History: Click the icon to open the History popup to see a detailed history of the case. 

1 
 2 

 

6 
 4 

 

3 
 

7 
 

9 
 

10 
 

11 
 

8 

12 
 

13 
 

14 
 

15 
 

16 
 

17 
 

5 
 

18 
 



  IMM eSign 2018.1 
  User/Document Administrator Guide  

 

Rev. 2/27/19  169 

8 Documents Tab: Click to view a list of the documents for the selected session. 

 
9 Signature Status Tab: Click to display details about the signature status of the 

documents. 

 
10 Comments Tab: All of the comments associated with the session are displayed. 

 
11  Take Ownership: Take ownership of the session. 
12 Route: Route the session. Refer to Routing Documents on page 74 for details. 
13 Re-Route: Re-route the session to a desired step or user. 

14 Reorder: Drag and drop the Reorder  icon to change a document’s order in the 
document set. 

15 Document Information: When this row is clicked in the Documents tab, index information 
is displayed. 

16 Preview: Click the Preview  icon to view a single document in a PDF popup window. 
From this window, you can view and print documents. Documents cannot be edited in 
Preview Mode. Click the icon for the Document Set to view all the documents in the set in a 
PDF popup window. Click the preview icon next to Session Audit to view the audit 
information for the session. Refer to Previewing and Printing Documents on page 24 for 
more information. 
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17 Delete: Click the Delete icon to the right of the document name to delete the document 
from the session. At least one document must remain in the list. Attachments can be 
removed. See Deleting a Session on page 134 for detailed information.   

18 Action Buttons: Click Save to save changes to the indexes in the Documents tab. Click 
Cancel to clear any changes made to the indexes in the Documents tab. 

Loan Coupons 
Refer to Processing Loan Coupons on page 20 for details. 

Starter Checks 
Refer to Processing Starter Checks on page 22 for details. 

Custom Links 
Click Processing > Custom Links, and then select a link that has been configured by your 
administrator. Up to three custom links may be displayed. This feature allows all users to 
navigate easily to frequently used websites outside of IMM eSign.  

Reporting 
The following sub-menu choices are available: 
Session Status 
Expiring Sessions 
Remote Signature Status 
Add-Ons 

Session Status 
The Session Status Report displays the status of all active sessions. To open the Session 
Status Report page, click Reporting > Session Status. 
The Page Help button provides a quick listing of icons and functions available and related to the 
Session Status Report page.  
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To search the status of all processed sessions, perform the following procedure: 
1. Click Reporting > Session Status. The Session Status Report page is displayed.  
2. Enter search parameters: 

  1    Pin Search Panel: Clicking in the pin will display  or 

collapse  the search parameters section of the page 
when the results are displayed.  

 2 Index Fields Region: Enter any search criteria in the 
available fields to narrow the search. The search fields 
displayed are controlled by the administrator. By default, 
the Date Range is 360 days. 

 3 Users: Click the field to search for documents belonging 
to one or more specific users. Choose from the 
dropdown list. Leave the field blank to search for 
documents owned by all users. Click outside the field to 
close the dropdown menu. The display of this field is 
controlled by the administrator.  

 4 Session Status: Click the field to search for specific 
sessions. Choose from the dropdown list. Leave the field 
blank to search for all session statuses. Click outside the 
field to close the dropdown list. 

 5 Action Buttons:  
 Click Search to continue.  
 Click Clear to reset the search parameters.  

 
3. The Session Status Report search results are displayed. 
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1 Export: Export the Session Status Report to a .csv file. 
2 Sort By: Click the Sort By button to choose the order in which the search results will 

appear (Date Modified Ascending, Date Modified Descending, Name Ascending, Name 
Descending). 

3 Detailed Audit: Click the Detailed Audit  icon to view the Detailed Audit Report in a 
PDF popup window. 

Expiring Sessions 
The Expiring Sessions Report displays active sessions that have not expired. 
1. Click Reporting > Expiring Sessions. The Expiring Sessions Report page is displayed. 

 
2. Enter the search parameters and generate a report: 

 1 Days till expiration: Include sessions with less than this number of days left before 
expiration. By default, this is set to 90 days. 

 2 Owner: Leave this blank to search documents for all owners or filter the search to include 
documents from the selected owner only. 

 3 Print: Click Print to view the Expiring Sessions Report in a PDF popup window. The report 
is sorted by Days Left in ascending order. 

 4 Export: Click Export to export the Expiring Sessions Report to a .csv file. The report is 
sorted by Days Left in ascending order. 

 
If there are more than 2,000 sessions in the report range, a message is displayed 
stating that the report may take several minutes to generate and asking if you would 
like to continue or change the Days till expiration field. 

When the Expiring Sessions Report opens in the PDF popup window, click the printer icon to 
print the report. A maximum of 10 index fields can be displayed in the report. Refer to the 
following example. 
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Remote Signature Status 
This report displays the status of all outstanding remote signature sessions. Document sessions 
that have been completed and cleared by the FI will not display. Completed sessions are listed 
for up to 14 days. Expired sessions are listed for one year. This report is available only if 
Remote Signatures is turned on.  
Click Reporting > Remote Signature Status. The Remote Signature Status Report page is 
displayed.  
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1 Pin Search Parameters: Clicking the Search Parameters bar will expand the search 

parameters or collapse the search parameters section of the page when the results are 
displayed. 

2 Exclude Aborted/Expired Sessions: When this field is selected, sessions that have been 
aborted or sessions that are expired will not be displayed in the search results. 

3 Include Downloaded Sessions that were submitted in the past # of days: Limit the 
listing to include downloaded sets for this number of days. This setting is based on the 
Date Submitted field and only applies to downloaded documents. 

 4 Index Fields Region: Enter any search criteria in the available fields to narrow the search. 
The search fields displayed are controlled by the administrator. 

 5 User: Click the field to search for documents belonging to one or more specific users. 
Choose from the dropdown list. Leave the field blank to search for documents owned by all 
users. Click outside the field to close the dropdown menu. The display of this field is 
controlled by the administrator.  

 6 Additional Search Fields: Add search fields as necessary. To add a search field, select a 
search field from the dropdown menu and click Add Search Field. The field is displayed 
with the other index fields.  

 7 Action Buttons:  
 Click Search to display the Remote Signature Status Report records.  
 Click Clear to reset the search parameters.  

 8 Document Set Name: The name of the document set is listed here.  
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 9 Signer Info : Click the icon to display the Signature Status popup. The possible 
statuses are Waiting for Signature, Pending Other Signers, Remotely Signed, Completed, 
and Expired. 

 
 10 Status: Current status of the document set based on the signature status. 
 11 Date Submitted: The date the document set was submitted for remote signature. Click the 

column title to sort the search results by newest or oldest. 
 12 Index Fields Region: These names vary by installation. Click the column title to sort the 

search results by that field. 
 13 Created By: User ID of the FI representative that created the document or document set. 

Click the column title to sort the search results by user. 

Add-Ons 

 
These reports are only available if the Starter Checks or Loan Coupons add-on is 
activated. 

This report lists any activities (Starter Checks/Loan Coupons created) in the current reporting 
period (by default, 90 days). 
Click Reporting > Add-Ons. The Add-Ons Report page appears. 
 1 Select the Add-On Type (Starter Checks or Loan Coupons). 

 

1 
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The Add-Ons Report page refreshes. 
 1 Select a search criteria from the Search By dropdown.  
 2 Enter a search string into the Value field. Wildcards are acceptable. The minimum value 

is the asterisk (*) and one additional character. 
 3 Select a user for Created By. 
 4 Click Run. 
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The Add-Ons Report lists all activity for that specific search criterion. 
Starter Checks Add-On Results 

 

Loan Coupons Add-On Results 

 

Clicking on color column titles sorts the list. Clicking the column title alternates between 
ascending and descending order. 
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Help 
The Help option provides diagnostics, documentation and general information about your IMM 
eSign system. 
Diagnostics 
Documentation 
About 
Diagnostics 
This option allows the user to validate that the system is working properly. The Diagnostics 
page checks to make sure that the system is able to perform all of the tasks required for the 
current user and that the proper permission have been set. 
Click Help > Diagnostics. The Diagnostics page is displayed. 

 
Documentation 
The FI representative can view the user documentation (this document) in a separate window 
by selecting this option. 
Click Help > Documentation. This document is displayed in a new window. 
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About 
This option displays a popup that provides system information: the current versions of the base 
product, add-ons that have been installed, and the product serial number. This information is 
available to all users. 
Click Help > About. The About page is displayed. 

User Name 
The user name of the FI representative that is logged in is displayed on the menu. There are 
two submenus: 
User Account Settings 
Workstation Scanner Settings 
User Account Settings 
This menu allows the user to change the Name, Default Sender Email, and Password fields. 
Click [User Name] > User Account Settings. The Users Maintenance page is displayed. 

 
 

 
User Account Settings may not be available for your logon method. 

 

 
The Partner Alias area is not functional for your installation. 
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Edit User Name and Email 
1 On the Users Maintenance page, click Edit. The page refreshes with only the Name and 

Default Sender Email fields unlocked.  

 

2 Edit the Name field and Default Sender Email field as necessary. 

3 Click Save to save the changes.  
Click Cancel to exit without saving. 
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Reset Password 
1 On the Users Maintenance page, click Reset Password. The page refreshes. 

 

2 Complete the following fields: 

• Original Password: Enter the password currently being used by the user to connect 
to eSign. 

• Password: Enter the new password. 

• Confirm Password: Reenter the new password 

 
The password must be at least 8 characters long and must contain one lower-
case letter, one upper-case letter and one numeric or special character. 

 

3 Click Save to save the changes. The Users Maintenance page refreshes and the new 
password is saved. 
Click Cancel to exit without saving. 

 



IMM eSign 2018.1  
User/Document Administrator Guide  

182 Copyright © 2019 IMM Rev. 2/27/19 

Workstation Scanner Settings 

 
The availability of the Workstation Scanner Settings menu is controlled by your 
Administrator. Your settings may differ from the ones displayed in this section 
depending on the Administrator settings. 

 
This menu allows you to edit workstation scanner settings. 

1 Click [User Name] > Workstation Scanner Settings.  

 
If this popup displays, click Install. 
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2 The Edit Scanner Settings - Workstation page is displayed. 

 
 1 Select a scanner from the dropdown menu. 
 2 Change settings as necessary for your configuration.  

 
The availability of scanner settings selections is dependent on your scanner. 
IMM does not recommend enabling the Show UI setting. 
High definition and large area scans will result in large file sizes. 

 3 Click Test to verify the settings. 
 4 Click Save Settings to save the workstation scanner settings. 
 5 Click Download eSign Scanner Service to download and install the eSign Scanner 

Service. 

 

Errors may occur if the eSign Scanner Service is not installed by a user with 
administrator privileges. IMM highly recommends the eSign Scanner Service is sav  
and then installed as an Administrator. 

 

Logout 
Click Logout to end the session. 
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IMM eSign Icon  
When you sign onto your workstation, you should see the IMM eSign icon   in the system 
tray.  
The icon in the system tray is used as an indication of the state of the program: 

 This icon indicates that IMM eSign is running normally. IMM eSign is able to 
communicate with the IMM eSign server, and documents will be processed in the 
normal fashion. 

 When the icon's background is teal, it is an indication that the client is unable to 
communicate with the IMM eSign server. Documents may be locally processed (on 
the workstation). Contact your administrator when the icon appears in the teal color 
background. 

 When the icon's background is red, it is an indication that the server was unable to 
process documents and the session resulted in an exception that will be saved to 
the exceptions folder. The red background disappears if the next processed session 
is successful. Contact your administrator to process the exceptions.  

 When the icon's background is yellow, it is an indication that a session is being 
processed in an Internet Explorer window.  

 

 
When you right-click on the IMM eSign icon ( ) in the system tray, a popup menu is 
displayed. 

IMM eSign Integrations IMM eSign plus Integrations 
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The following choices are available depending on your integration: 

• Show Documents: Selecting this option displays the Documents List page. Refer to 
Manual Output Folder on page 11 for details. 

• Settings: This option is for Administrator use only. Refer to the Client Installation Guide 
for more information on these settings. 

• Exceptions: This option allows the user to select a session that has been previously saved 
locally as an exception session. The Exceptions window displays all the documents that 
resulted in an exception. 
o Click Process to reprocess the document. 
o Click View Log to view the error log for the document. 
o Click OK to close the Exceptions window. 

 
• Search Active Sessions: This option allows the user to find sessions that have been 

previously saved on the server. When selected, the Search Active Sessions page opens. 
Refer to Search Active on page 144 for details. 

• Search Completed Sessions: This option allows the user to find documents that have 
previously been archived that are not moved to an imaging system. When selected, the 
Search Completed Sessions page opens. Refer to Search Completed on page 164 for 
details. 

• Cases: This option allows the IMM eSign plus users to navigate directly to the Cases page. 
This page contains a list of tasks that a user needs to complete. Refer to Cases (eSign 
plus) on page 166 for details. 

• State: When you hover over this option with your mouse, a message will display describing 
the current status of the application either online or offline. When IMM eSign is offline, 
contact your Network Administrator.  

• About: This option displays the current version and copyright information. 

• Exit: Click this option to exit the application. 
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eSign Scanner Client Icon 
The eSign Scanner client software is a component of IMM eSign. Like IMM eSign, the eSign 
Scanner icon is displayed in the system tray. The purpose of the eSign Scanner Client icon is to 
provide the state of the scanner. 

 When the icon is green, the eSign Scanner Client is running and items can be scanned. 

 When the icon is orange, items cannot be scanned.  
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Common Routines 
Search Hints 
On some menus you can search for documents, completed documents or active session 
documents. You may be able to search for customer name, customer number, or other items. 
You can use wildcard characters to find documents that contain full or partial terms or match 
a character pattern. 
* The asterisk matches any number of characters. 
? The question mark matches any single character. 
Examples 
Jo* Matches names such as John, Joe, Joanna, Joaquin and Joseph. 
*on Matches names such as Peterson, Anderson, Paterson and Wilson. 
*n* Matches names such as Robinson, Hernandez, Jones and Martinez 
?23 Matches 123, 223, 323, 423, etc.  
1??4 Matches 1234, 1324, 1444, 1574, etc. 
1?3* Matches 123, 1234454, 1739999, 1931, etc. 

Calendars 
Start/End Date 
In the Start Date and End Date fields, click the Calendar 
button ( ). The Calendar popup is displayed. 
Use the < and > buttons to select the month and year. 
Click the day of the month. The calendar closes automatically 
when the date is selected. 
Click the Calendar button again to close the popup without 
changing the date. 
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Date Range 
In the Date Range field, click the text box. The Calendar popup is displayed. 

 
Use the < and > buttons to select the month and year. 
Click the start day and then the end day. The range is highlighted in blue. The calendar closes 
automatically when the date range is selected. 
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Using an iPad 

 
After using IMM eSign on an iPad, it is important to log out and to close the browser 
for security. 

 
When using an iPad, many of the functions are the same as using a PC. To get started with 
IMM eSign on an iPad, refer to the following sections: 

• To save the IMM eSign URL as a favorite, refer to Save the IMM eSign URL as a Favorite 
on page 189 for details. 

• Log in following the Logging In section on page 9. 

• After logging in, the Search Active Sessions page is displayed. Refer to Search Active on 
page 144 for more information. 

• The iPad does not display the same menu items that a PC does. Refer to IMM eSign 
Menus on an iPad on page 189 for an overview of the menu items that are displayed when 
using an iPad. 

• Log out by clicking the Logout menu, and then close the web browser. Refer to Logout on 
page 183 for details on the Logout menu. 

IMM eSign Menus on an iPad 
The iPad displays three IMM eSign menu items: 

• Processing 
o Search Active: Click this menu item to search for active sessions. Refer to Search Active 

on page 144 for more information. 
o Search Completed: Click this menu item to search for completed sessions. Refer to 

Search Completed on page 164 for details. 
o Loan Coupons: Click this menu item to access the Add-Ons Processing page. Refer to 

Processing Add-Ons on page 20 for details. 
o Starter Checks: Click this menu item to access the Add-Ons Processing page. Refer to 

Processing Add-Ons on page 20 for details. 

• User Name: This item displays the name of the user. Clicking this item does not route you to 
another page. 

• Logout: Click this menu item to log out of IMM eSign. Close the browser after logging out. 
Refer to Logout on page 183 for general information. 

Save the IMM eSign URL as a Favorite 
Instead of manually entering the IMM eSign URL on the iPad every time you need to access 
IMM eSign, you can save the URL by adding it as a favorite on an iPad. To save the IMM eSign 
URL as a favorite on an iPad, perform the following procedure: 
1. In the Safari web browser, navigate to http://[YourServer]/teaasp/Login.aspx. 
2. If prompted, perform the following action depending on your authentication settings: 

• For Windows Authentication, enter your domain\username and password to log in. 
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• For Anonymous Authentication, enter your local user account credentials to log in. 

 
For Anonymous Authentication, FIAdmin may have to reset all auto-create 
user passwords in IMM eSign. 

3. On the Login Screen page, tap the Action  button and then click Add to Favorites. 

 
4. In the Add to Favorites window, enter a title such as “IMM eSign Login.” The URL is 

displayed below the title. 

 
5. Click Save. The IMM eSign URL is added as a favorite. 
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6. After the favorite is created, open IMM eSign using the URL field or the Bookmarks 

 button: 

• To use the URL field, tap the URL field and then tap the icon that represents IMM eSign 
(e.g., “IMM eSign Login”). 

 

• To use the Bookmarks  button, tap the Bookmarks  button, tap Favorites, 
and then tap the name that represents IMM eSign (e.g., “IMM eSign Login”). 

 

Refer to Logging In on page 9 to continue the login process. 
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Document Administrator Supplement 
Overview 
This section provides an overview of the procedures available to users with document 
administrator privileges (DocAdmin). Images in this guide are from Windows 10 with Internet 
Explorer 11. Your screens may differ with a different OS or browser. 

Groups and Users - Roles and Responsibilities 
The following groups and users are automatically created when IMM eSign is installed: 

Groups 
• Users: Created in IMM eSign by the FI Admin. Able to process documents, save and retrieve 

sessions, archive documents and search archived documents and saved sessions. The 
FIUser is a member of the Users group. 

• DocumentAdmins: Same rights as Users plus able to define and maintain documents. The 
DocAdmin is a member of the Document Admins Group. 

• Administrators: All rights of Users and DocumentAdmins plus able to control all FI-level 
settings. The FIAdmin is a member of the Administrators group. 

Users 
• FIUser: Able to process documents, save and retrieve sessions, archive documents and 

search archived documents and saved sessions.  

• DocAdmin: Same rights as Users plus able to define and maintain documents. 

• FIAdmin: All rights of Users and DocumentAdmins plus able to control all FI-level settings. 

• HostAdmin: The ability to control Host-level settings, such as enable Add-ons, maintain 
Financial Institution (FI) settings, and modify service level. 

DocAdmin Menus 
After the DocAdmin (Document Administrator) logs in, the Search Active Sessions page is 
displayed. Use the menu bar on the upper right-hand side of this screen to perform document 
administrator duties for your financial institution. The User ID displays in the upper right corner. 

 
The following sections describe the DocAdmin menu options available along with brief 
descriptions of their functionality: 
Processing - Same functions as a user 
Reporting - Same functions as a user 
Administration - Functions specific to the Document Administrator (DocAdmin) 
Help - Same functions as a user 
User Name - Same functions as a user 
Logout - Same functions as a user 
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Administration 
The following sub-menu choices are available for the DocAdmin from the Administration menu: 
Documents (XML) 
Documents (RTS) 
Document Sets 
Workflow Builder 
Criteria (XML Only) 
Remote Attachment Template 
Documents (XML) 
The Document Maintenance page allows the Administrator to change descriptions, criteria and 
other settings for individual documents.  
The Administrator can use this page to upload, edit and delete documents. The Document 
Maintenance page can also be used to link documents to a specific host dictionary, set the 
default display flags, assign criteria to a document and set the recurrence type.  
Click Administration > Documents. 
The Document Maintenance page is displayed. 
Document Maintenance Page - No Documents 

 
 



IMM eSign 2018.1  
User/Document Administrator Guide  

194 Copyright © 2019 IMM Rev. 2/27/19 

Document Maintenance Page - Populated 

 

 1 Search by: A search filter is available to assist in locating your documents. Refer to 
Search (for Documents) on page 202 for more information.  

 2 Document Maintenance Action Buttons:  
 Upload Documents: Upload documents. Existing documents with the same name will 

be overwritten. Refer to Uploading Documents on page 195 for more information. 
 Delete Selected: Delete selected documents. Refer to Deleting Documents on page 

201 for more information. 
 Define Attachment: Define an attachment category. Refer to Attach Documents on 

page 198 for more information.  
 Export: Export a comma delimited file listing document information from this page. 

 3 Page Control: Lists the number of pages for documents. Each page lists 10 documents. 
Click the number to jump to that page. 

 4 Document Selection: Select individual or all documents for deletion. 
 5 Document Name: The name of the document. The name cannot be changed on this page. 

Refer to Edit (Documents) (Alternate Method) on page 203 for more information. 
 6 Description: Document Description (150 characters maximum) 
 7 Dictionary: Select a Dictionary type. If the document has already been assigned to a 

Document Set, this field cannot be edited. First, remove the document from all document 
sets. Second, return to this page and edit the Dictionary. Last, add the document back to 
all document sets. The dictionary cannot be changed on this page. Refer to Edit 
(Documents) (Alternate Method) on page 203 for more information. 

 8 Criteria: Select any required criteria. Refer to Criteria (XML Only) on page 224 for more 
information. (Locked for Imported Documents) 

1 

 
2 
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 9 Recurring Type: None, Recurring or NonRecurring. Refer to Recurring Forms 
Guidelines on page 205 for more information. (Locked for Attached Documents) 

 
Documents that use app prefixes O1_, O2_, etc. set at the dictionary level must 
have Recurring Type set to None. 

 10 Display Document While Processing: When this is checked and documents are 
processed, they will display. Unchecking this checkbox only prevents the document from 
displaying; the document will still be processed. (Locked for Attached Documents) 

 11 eVault Document: Checked documents are sent to eVault for auditing and tracking of the 
original document. When eVault documents are included in a session, all documents in the 
session will be sent to eVault for auditing and tracking. (Not available for eSign Lite 
installations) 

 12 Show Other App in App Section: This setting only affects documents when they are 
Recurring Documents. Other App is a Co-Applicant (not a Spouse). When this setting is 
checked, Other Applicant information (not the primary) is displayed in the Primary Applicant 
section. (Locked for Attached Documents) 

Original Document Show Other App in App 
Section Disabled 

Show Other App in App 
Section Enabled 

   
 13 Archive Document: When checked, the document will automatically be archived when 

processed by itself or as part of a document session. When not checked, the document will 
not automatically be archived. This setting can be overridden during the document 
selection process only if the document is preselected to not be archived (only if this 
checkbox is cleared). Refer to the User Guide for more information. (Not available for 
eSign Lite installations) 

 14 Attachment: Documents that have this box checked are additional documents that may be 
included with document sets. Refer to Attach Documents on page 198 for more 
information. (Not available for eSign Lite installations) 

 15 Vendor: Select the supported third party from the dropdown so that the signature fields in 
third-party documents are automatically recognized.  

Uploading Documents 
 

 
Use only original PDF documents. Documents from the server’s FI\SourcePDFs 
folder should not be re-uploaded. 

1 From the Document Maintenance page, click Upload Documents. 
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2 The Upload Documents page is displayed. 

 
 1 Dictionary: Select a Dictionary from the drop-down. 
 2 Drop Files Here: Drag and drop existing PDF documents. 
 3 Select Files: Navigate to and select the directory with your documents. Select one 

or more documents to upload. Click Open. 
 

3 The Upload Documents page refreshes. 

 
Click Upload. 

1 

 
2 

 

3 
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4 The Open window is displayed. 
Navigate to and select the directory with your documents.  
Select one or more documents to upload. 

Click Open. 

 
Press Ctrl-A to select all files. 

 
 

PDF Document Names 
Depending on your document storage and indexing specifications, PDF 
document names may be used as part of a document name or document set 
name. For this reason, a document name cannot use the following characters: 
Space, Underscore (_) or Caret (^). 
Examples: 

“Your Document Name.pdf” Invalid name Uses spaces 
“Your-Document-Name.pdf” Valid name Dashes are allowed 
“YourDocumentName.pdf” Valid name Uses no special characters 

  
 

5 The Upload Documents window refreshes. 
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6 Successfully uploaded documents will display a checkmark.  
Failed uploads will display a red X. 

 
Click the document row for more information. 

7 Failed upload explanation 

 

8 Repeat steps 1-5 for any additional dictionaries. 

9 The Document Upload process is complete. 

 
When documents are successfully uploaded they will be moved to an 
Uploaded folder under the folder they were in. 

 

10 After documents have been uploaded, edit document field information as necessary.  
As necessary, add documents to Document Sets.  Refer to Document Sets (XML Only) 
on page 216. 

Attach Documents 

 
Not available for eSign Lite installations. 
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An Attached Document is a PDF document external from the normal IMM eSign document 
system. This could be a driver’s license, passport, a written set of instructions, or any other 
document in PDF format. 
Predefined PDF documents from selected third parties may also be uploaded as attachments. 
Refer to the User Guide for information on adding and using Attached Documents when 
processing document sets. 
Before they can be used with document sets, attached document categories must be set up. 

1 On the Document Maintenance page, 
Click Define Attachment.  
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2 A new row is displayed. 

 
The following information can be modified for an attached document: 
 1 Document Name: For attached 

documents, the document name is 
more like a type or category than an 
actual name. You can scan a passport 
and save it as any name. When the 
document is added into the document 
set, the Document Name and the 
filename will be required information. 

 
The Document Name field used 
for defining imported documents 
should not include a .PDF 
extension.  

 2 Description: A description of the document. “Attachment” will automatically be 
prefixed to the description when Update is clicked. 

 3 Dictionary: Select a dictionary from the dropdown. 
 4 Archive Document: When checked, the document will automatically be archived 

when processed as part of a document set. When not checked, the document will 
not automatically be archived. This setting can be overridden when processing the 
document set. [Default: Checked ] 

 5 Attachment: The Attachment checkbox is automatically checked. 
 6 Vendor: Where applicable, the name of the third party supplying this type of 

attachment.  
Click Update to save the information. 
The Attach Document is added to the document list. 

User’s Attach Documents Popup 

 

1 

 

2 

 

3 

 

5 

 

4 

 

6 
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Deleting Documents 

From the Document Maintenance page, 

 
 1 Check the box to the left of the document to be deleted. 
 2 Check the box at the top of the column to select all documents. 
 3 Click Delete Selected. 
Click OK to the message popup. 

 
Deleting a document will remove that document from all document sets. 
Do not delete a document during business hours. 

3 

 
2 

 1 
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Search (for Documents) 
A search filter is available to assist in locating your documents. 

 
• Select the Search By drop-down field. 

o None: After completing a search, select None and click Search to view all documents. 
o Document Name: This will search for all documents matching the search parameter. 
o Dictionary: This will search for all documents in the selected dictionary. 

• Enter the document or dictionary name. (When searching for a document, the asterisk “*” 
can be used as a wild card character.) 

• Enter the search parameter (document or dictionary name).  
Click Search.  
The Document Maintenance page refreshes listing the results of the search. 

Edit (Documents) 
From the Document Maintenance page, 

 
Click Edit to the left of the document name. 
The Document Maintenance page refreshes with the document fields unlocked. 
Edit the document field information as necessary. 
Click Update. 



  IMM eSign 2018.1 
  User/Document Administrator Guide  

 

Rev. 2/27/19  203 

Edit (Documents) (Alternate Method) 

1 Another method of editing document field information is to click on the document name. 
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2 The Edit Document page is displayed. 
Click Edit. 
The Edit Document page refreshes with the 
document fields unlocked. 
Edit the document field information, as necessary. 
All field definitions from page 193 are the same. 
Additionally: 
 1 Document Name: The name can be changed 

on this page. Note: When you change the 
name a document, the associated document 
sets and the criteria are automatically 
updated. These changes must be made on 
your imaging system for successful document import. 

 2 Parties Allowed to View: Select any party that will be allowed to view the document 
during processing. Multiple parties may be allowed and will be controlled by the user 
during the processing and signing processes. 

 3 Unlock Selected Fields: (For Data Locking) When documents are processed by the 
Process button, fields are locked (no changes can be made to the field information). 
You may need to modify information as the document is processed. For example, a 
phone number change or a driver’s license number may need to be changed. These 
fields must be unlocked on this page to give your users the ability to modify the 
contents of the field.  
Notes:  
 All HOST (XML populated) fields will be locked by default. Use this settings to 
unlock those fields. 
 All HOST fields which are blank (have no value) in the XML source will remain 
open prior to signing. 
 All GENERIC (non-XML) fields will remain open prior to signing. 
 If all signers sign the session successfully, all fields will be locked EXCEPT fields 
prefixed with “IMM_UNL_”. These fields will not be listed in the above screen as it 
will always remain unlocked. 

 4 Action Buttons:. 
 Edit: Unlocks all editable fields for making changes. 
 Save: Click to save changed settings. 
 Cancel: Click if you do not want to save any changes. 

 5 Document Sets: The lower part of this page lists the Document Sets that use this 
document.  

After completing changes, 
Click Save. 

Document Sets 

1 

 

2 

 

3 

 

4 

 5 
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Recurring Forms Guidelines 
There are three possible recurring behaviors for lending documents: Recurring, Non-recurring, 
and None. 

• Recurring: This option takes relationships into account to ensure personal information is not 
distributed to other applicants. For example, the Primary Applicant and Spouse are on one 
document because personal information can be shared between spouses, and then a 
separate document is generated for each Co-applicant/Other applicant. 

• Non-recurring: The non-recurring behavior ignores relationships between applicants. When 
this option is selected, Spouses and Co-applicants/Other applicants are treated the same.  

• None: “None” is ideal for applicant-specific documents, such as an adverse action document. 
For example, a loan guarantee is for a Guarantor applicant only. 

There are two components involved in determining the behavior of documents:  

• Document Mapping: The fields used in a PDF template. 

• Data Source: An XML file that is passed from the Host System to IMM eSign. For example, 
the Data Source can have data for the following applicants: 
o Primary Applicant: The field label for this group is A_ or P_. 
o Spouse: The field label for this group is C_. 
o Co-applicant/Other Applicant: The field label for this group is O_ (O1, O2, etc.) 
o Guarantor: The field label for this group is G_ (G1_, G2_, etc.) 

The recurring behavior allows the applicant information to display automatically for each 
applicant if the following elements are correct: 

• The applicant’s role or association with the loan/account (Refer to the “Required Fields’ Prefix 
with Data Source” column in the following table.) 

• The required fields’ prefixes (Refer to the “Required Fields’ Prefix with Data Source” column 
in the following table.) 

• The field mapping of the document (Refer to the “Document Mapping” column in the following 
table.) 
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Refer to the following table for details. 

Behavior Document 
Mapping 

Required Fields’ Prefix  
with Data Source 

Result  

Recurring 
(Lending 
Dictionary - 
Optional) 

1st applicant:  
A_ or P_ 
 
2nd applicant: 
C_ 

Primary Applicant:  
A_ or P_ 
 
Spouse: C_ 
 
Co-applicant/ Other 
Applicant: O1_, O2_, etc. 

Generates one document 
copy for Primary AND 
Spouse 
 
AND 
Generates a separate 
document for each 
Co-applicant/Other 

Non-recurring  
(Lending 
Dictionary - 
Optional) 

1st applicant:  
A_ or P_ 
 
2nd applicant: 
C_ 

Primary Applicant:  
A_ or P_ 
 
Spouse: C_ 
 
Co-applicant/ Other 
Applicant: O1_, O2_, etc. 

Generates one document 
copy for Primary AND 
Spouse OR 
Co-applicant/Other 
 
AND 
Generates a separate 
document for each 
additional Co-applicant/ 
Other 

None 
(Lending and 
Membership 
Dictionaries - 
Mandatory) 

1st applicant:  
A_ or P_ 
 
2nd applicant: 
O1_ 

Primary Applicant:  
A_ or P_ 
 
Co-applicant/ Other 
Applicant: O1_, O2_, etc. 

Generates a document for 
Primary AND/OR 
Co-applicant/Other 

 

 
• If documents are mapped incorrectly for the second applicant, then “recurring” or 

“non-recurring” options will not work as described in the previous table. 

• If documents are mapped for the second applicant with prefix O1_, the recurring 
option MUST be set to “None.” The option of automatically generating a separate 
document for each non-spouse WILL NOT be available for those documents. 

• If your document should be mapped for two borrowers, the correct prefix for the 
second applicant is always C_. IMM eSign automatically populates the C_ fields in 
case the XML data has O1_ as the field’s prefix for the second applicant. 

• Creation of a separate document for each Co-applicant/Other Applicant is supported 
only for the applicant with prefix O1_, O2_, O3_, etc. The document that contains 
other field prefixes, such as GA1_ for guarantor, should be explicitly mapped for 
each guarantor (GA1_, GA2_, etc.). 

• If the document should be generated for other applicant prefixes besides C_ and 
O1_ (O2_, O3_, etc.), then IMM eSign document MUST be mapped accordingly. For 
example, if an IMM eSign document needs to display two guarantors, then the prefix 
for the first guarantor should be GA1_ and the second guarantor should be GA2_. 
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Refer to the following tables of examples where the Data Source for Primary Applicant is A_, 
Spouse is C_, First Co-applicant/Other Applicant is O1_, Second Co-applicant/Other 
Applicant is O2_, and Guarantor is G1_. The guidelines provided below apply to lending 
application forms only. 

Document Mapping Behavior Result 
Primary (A_) 
Spouse (C_) 

Recurring and 
Non-recurring 

Document 1 – Primary and Spouse (A_ and C_) 

Primary (A_) 
Co-applicant/ 
Other Applicant 
(O1_) 

Recurring Document 1 – Primary Applicant (A_) 
Document 2 – Co-applicant/Other Applicant (O1_) 

Non-recurring Document 1 – Primary and Co-applicant/Other 
Applicant (A_ and O1_) 

Primary (A_) 
Two Co-applicant/ 
Other Applicants 
(O1_ and O2_) 

Recurring Document 1 – Primary Applicant (A_) 
Document 2 – First Co-applicant/Other Applicant 
(O1_) 
Document 3 – Second Co-applicant/Other Applicant 
(O2_) 

Non-recurring Document 1 – Primary and Co-applicant/Other 
Applicant (A_ and O1_) 
Document 2 – Second Co-applicant/Other Applicant 
(O2_) 

Primary (A_) 
Spouse (C) 
Co-applicant/  
Other Applicant 
(O1_) 

Recurring and 
Non-recurring 

Document 1 – Primary and Spouse (A_ and C_) 
Document 2 – Co-applicant/Other Applicant (O1_) 

Primary (A_) 
Spouse (C_) 
Two Co-applicant/ 
Other Applicants 
(O1_ and O2_) 

Recurring and 
Non-recurring 

Document 1 – Primary and Spouse (A_ and C_) 
Document 2 – First Co-applicant/Other Applicant 
(O1_) 
Document 3 – Second Co-applicant/Other Applicant 
(O2_) 

Primary (A_) 
Spouse (C) 
Co-applicant/ Other 
Applicant (O1_) 
Guarantor (G1_) 

Recurring and 
Non-recurring 

Document 1 – Primary and Spouse (A_ and C_) 
Document 2 – First Co-applicant/Other Applicant 
(O1_) 
Document 3 – Guarantor (G1_) 

 
 



IMM eSign 2018.1  
User/Document Administrator Guide  

208 Copyright © 2019 IMM Rev. 2/27/19 

When “None” is selected, all of the applicants are grouped together except the applicant that 
is particular to the “applicant-specific” document. 

Document Mapping Behavior Result 
Primary (A_) 
Spouse (C_) 

None Document 1 – Primary and Spouse (A_ and C_) 

Primary (A_) 
Spouse (C) 
Co-applicant/  
Other Applicant 
(O1_) 

None Document 1 – Primary, Spouse (A_ and C_), and 
Co-applicant/Other Applicant (O1_) 

Primary (A_) 
Spouse (C) 
Co-applicant/ Other 
Applicant (O1_) 
Guarantor (G1_) 

None Document 1 – Primary, Spouse, and Co-
applicant/Other Applicant (A_, C_, and O1_) 
Document 2 – Guarantor (G1_) 
In this case, the Guarantor (G1_) is the applicant that 
is particular to the “applicant-specific” document. 

 

 

Documents (RTS)  

Click Administration > Documents (RTS) to access the Documents Maintenance (RTS) page. 
This page is used to add attachments and delete documents in conjunction with Admin 
Manager. The administrator can rename parameters, delete sessions and add/define 
attachments. 
The Page Help button provides a quick listing of icons and functions available and related to the 
Documents Maintenance (RTS) page. 
 

    
 
 
 
 
 

 
This page may not display for your installation. 
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Default View 

 
 1 Title Bar: Click the title bar area to expand/minimize the search pane. 

 2 Pin/Unpin: Clicking in the pin will display  or collapse  the search parameters 
section of the page when the results are displayed. 

 3 Document Type: Search for All Types, Document or Attachment. 
  -Or- 
 4 Document Name: Search by document name.  
 5 Search Pane Action Buttons: 

 Search: Search documents based on the selected parameters. 
 Clear: Close existing results and clear search parameters. 

 6 Define Attachment: Click this button to define a document attachment. Refer to Define 
Attachment on page 214 for more information. 

 7 Delete (Selected Documents): Use Select All (8) or Select Individual (9) to select 
documents. Click Delete (7) to delete the selected documents. Click OK to the Delete 
Document confirmation popup to complete deleting. 

 8 Select All: Click to select all documents and attachments. Click again to unselect all. 
 9 Sort By: Click to select sort method. 
 10 Select (Individual Documents): Click to select one or more documents and attachments. 
 11 Document Information: Click to expand the document information. 
 12 Delete (Current Session): Displays for attachment definitions. 
 13 Attachment Icon: Displays for attachment definitions. 

1 
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Expanded View 

 

Expanded 
Document 

Expanded 
Attachment 

Tabs 
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Details Tab 

 
 1 Full Name: The Full Name is used in indexing and defaults to the current filename, but can 

be modified at this point. (90 characters maximum). 
 2 Short Name: Used in creating the filename for archive documents. (20 characters 

maximum] 
 3 Description: Used for the Document Description column. An easy to recognize description 

of the document. (140 characters maximum) 
 4 Archive: Click to toggle between Yes and No. When Yes, the document can be archived. 

When No, the document will not be archived. 
 5 Display Document While Processing: When checked and documents are processed, the 

documents will display during processing by default. When not checked the document may 
still be optionally displayed while processing. (This setting does not display for 
attachments.) 

 6 Results Pane Action Buttons:  
 Save: Click this button to save changes to a document. 
 Cancel: Click to cancel changes to a document. 
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Index Fields Tab 
Only fields that have been marked by your administrator as “Use for Imaging” are available on 
this screen. Additionally, if your system uses XML files with field definitions, those defined fields 
will appear here. 
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Imaging System Tab 
This screen changes according to the currently selected Imaging System. Refer to the Imaging 
Index Service Admin Guide for detailed information. 
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Define Attachment 

An attached document is a PDF document external from the normal IMM eSign document 
system. This could be a driver’s license, passport, a written set of instructions, or any other 
document in PDF format. 
Predefined PDF documents from selected third parties may also be added as attachments. 
Refer to Adding Documents on page 60 when processing document sets. 

 
Encrypted PDF documents cannot be attached. 
Attached documents must be less than 5 MB in size. 
A maximum of 10 documents can be attached per session.  
A maximum of 100 document pages can be attached when the session will be sent 
for remote signatures. 
Supported file formats are BMP, GIF, JPEG, JPG, PDF, PNG, TIF, and TIFF. 
Attachments will be downloaded as PDF documents. All attachments will be 
converted to PDF documents and saved as separate files. 

 

 
This procedure only applies to installations that do not use AIM. 
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Before they can be used with document sets, attached document categories must be set up. 
After clicking Define Attachment on the Document Maintenance page, the Define Attachment 
popup is displayed. 

 
Complete all information: 
 1 Full Name: The Full Name is used in indexing and defaults to the current filename but can 

be modified at this point. (90 characters maximum) 
 2 Short Name: Used in creating the filename for archive documents. (20 characters 

maximum) 
 3 Description: Used for the Document Description column. An easy to recognize description 

of the document. (140 characters maximum) 
 4 Archive: Click to toggle between Yes and No. When Yes, the document can be archived. 

When No, the document will not be archived. 
 5 Vendor: Where applicable, the name of the third party supplying this type of attachment. 
 6 Action Buttons: 

 Save: Click this button to save changes to an attachment. 
 Cancel: Click to cancel changes to the current attachment. 
 Close: Close the popup without saving any changes. 

 
Indexes must be defined for attachments using the Index Fields tab.  
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Document Sets (XML Only) 
Click Administration > Document Sets. 
The Document Sets Maintenance feature allows the Document Administrator to group related 
documents in a logical set. 
With this option, you can add and remove documents that are required for a given set, such as 
a checking account, an IRA, etc. You may also modify the behavior of the documents in the set 
(whether or not they will display, how many copies need to be printed, whether the document is 
required, and the recurrence type). 

 
Add Document Sets 

1 From the Documents Sets Maintenance page, click Add Document Set. 
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2 The Add New Document Sets page is displayed. 

 
The following information is necessary to create a new Document Set. 

• Document Set: The reference title may contain letters, numbers and the underscore (_) 
character but may not contain a space in the title. 

• Description: Enter a description for the document set. 
• Dictionary: Choose a dictionary as a source for the documents. 
Click Save. 

3 The new document set information is saved. 
The Add New Document Sets page refreshes with additional information. 

 
Click Add Documents. 
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4 The Add New Document Sets page refreshes showing available documents from the 
selected dictionary. 

 
A basic search tool is available to assist the Administrator to locate documents. Enter the 
document name (only the asterisk “*” may be used as a wild card character). Click 
Search. 
 1 Check the checkbox next to the documents to be included in the document set. 
 2 Check the checkbox next to the Document Name column head to select all 

documents. 
Click Add Selected Documents. 

5 The documents are added to the set. 

 
Use  and  to move the documents up or down in the display order. 
At this point, document settings within the document set can be edited.  Refer to Modify 
Document Sets on page 220 for more information. 

1 

 
2 
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Edit Document Sets 

1 From the Document Sets Maintenance page, click Edit to the left of the document set 
name. 

 

2 The Document Sets Maintenance page refreshes with the document set fields unlocked. 

 
Edit the document set field information, as necessary. 

• Description: Modify the description for the document set. 
• Dictionary: Change the dictionary as a source for the documents. 
Click Update. 
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Modify Document Sets 

1 From the Document Sets Maintenance page, click the Document Set name. 

 

2 The Edit Document Sets page is displayed. 

 
The upper portion of this page can be used to edit the Document Set Description and 
Name.  
 1 Click the Edit button to unlock the Document Set Information Fields and make 

changes. The lower portion of this page is used to add, delete and edit document 
information for the selected document set only. 

 2 Click the Edit link to the left of the document name to unlock individual documents 
within the set. 

1 

 

2 
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3 The Edit Document Sets page refreshes with the document information unlocked. 

 
The following document information can be edited. 

• Required: Select if the document is required for this set. 
• # Print Copies: Number of copies to print. 
Use  and  to move the documents up or down in the display order. 
Click Update to exit the edit mode and save changes. 
Click Cancel to exit the edit mode without saving changes. 

 
Display Document While Processing cannot be edited on this page. This is a 
document-only setting. Refer to Display Document While Processing on 
page 195 for more information. 

 

Delete Document Sets 
Delete the document sets from the Document Sets Maintenance page: 

 
 1 Check the box to the left of the document set to be deleted. 
 2 Check the box at the top of the column to select all. 
 3 Click Delete Selected. 
Click OK to the message popup. 

1 
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Workflow Builder 
Workflow Builder is used to create, modify and publish workflows for IMM eSign plus 
integrations. A workflow is a process, or a programmed set of instructions, used to guide 
documents and document sets through various approval, review and completion steps at your 
Financial Institution.  
Click Administration > Workflow Builder. 
The Workflow Builder page is displayed and the In Development radio button is selected. 

 
All current workflows in development are listed. 
Select the radio button for a workflow and choose an action from the dropdown menu. 

• Actions: The following actions are available. 
o Create Workflow: Used to design a new workflow. 
o Edit Workflow: Allows editing existing workflows. Double-clicking on a workflow row will 

open the workflow in edit mode. Editing a published workflow will create a copy of the 
workflow, increment the version number and open the workflow in development. 

o Publish Workflow: Moves the workflow into the Published Version screen. The published 
version will be incremented. 

o Copy Workflow: Creates a copy of an existing workflow. 
o Delete Workflow: Removes a workflow. 

 
In Development workflows can be deleted.  
Published workflows cannot be deleted if there are in-work tasks associated with 
the workflow. 

o Import Workflow: Imports a workflow from a different Financial Institution from an XML 
file. 

o Export Workflow: Exports a workflow to an XML file. 
o Version Management: Allows a workflow to be republished or replaced with a previous 

version. 
• Published Version: Displays a list of published workflows. 
• In Development: Displays a list of workflows that are being worked on. 
Workflow Building Tips and Recommendations 
Before getting started with building a Workflow, here are a few tips and recommendations to 
guide you along the way.  

• Create the group inboxes prior to modifying the Steps and Responses for the intended 
workflow. If applicable assign email accounts to group inboxes. IMM recommends assigning 
the Imaging or IT department to the Imaging inbox. 
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• Add the Steps prior to adding responses. 
• For viewing and organization purposes, sort the Steps in chronological order 
• Assign the workflow to applicable Document Set(s).    
• IMM recommends a Document Set is associated to a single Workflow. 
• Test the workflow with all responses and scenarios. 

(Example: Routing, signature capturing, alerts and archiving into optical) 

• After testing is completed, publish the workflow and assign group & user permissions to the 
workflow. 

Importing a Workflow 
IMM will provide the institution with a Master Workflow consisting of the required Steps with 
commonly used Responses. Below are instructions on importing and creating a copy of the 
Master Workflow.  The institution will modify the copied workflow to reflect the additional steps 
and responses as needed. 
Log into IMM eSign with Workflow Administrator permissions.  
Click Administration > Workflow Builder. 
Import the Master Workflow 
1. Select Import Workflow from the Actions dropdown. 
2. Browse to the Workflow.xml and click Import. 
3. Select Yes to add the shared inboxes. 
4. Click OK on the Imported Successfully message prompt. 
5. Refresh the webpage. 
Publish the Master Workflow 
1. Click the In Development radio button. 
2. Select the Master Workflow radio button. 
3. Select Publish Workflow from the Actions dropdown. 
4. Enter comments and Save. 
Copy the Master Workflow 
1. Click the Published Version radio button. 
2. Select the Master Workflow radio button. 
3. Select Copy Workflow from the Actions dropdown. 
4. Edit the Workflow Name and Description then click Save (indicate a name that will be 

published for production use).   
5. Now, customize the workflow specific to your internal processes. Additional configuration 

(Conditional Routing, Notifications and Time based alerts) can be added to the defined steps 
and responses. 
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Criteria (XML Only) 

 
Please Contact IMM Support for assistance with creating or working with criteria. 

Criteria are conditional statements that will disable documents if the condition is FALSE and 
enable the documents if the condition is TRUE. Criteria is triggered based on the host data 
file’s target field and value.  
Administrators may use this option to add, edit and delete criteria.  
For example, Power of Attorney (POA) forms vary from state to state. By defining criteria for 
each state that an FI does business in and associating those criteria to the different POA 
forms an administrator can assure that only the correct form will be processed.  
Click Administration > Criteria.  

 

Criteria Reference Material 
Criteria conditions in IMM eSign can be any valid XPath expression. IMM eSign evaluates this 
XPath expression for the transformed/orig xml file created (XML sent by the host is processed 
with our XSL which then creates the transformed/orig file) and counts the nodes that satisfy the 
XPath condition. If the node count is greater than 1, then the document that has the criteria 
attached is available for processing. If the node count is 0, then the document is not available 
for processing. 
Some of the commonly used operators/functions are listed below with examples: 
Operator/ 
Function 

Criteria Condition Converted XPath Expression1 Description 

= APP1_ADDR_CITY=’New York’ //*[APP1_ADDR_CITY=’New York’] Criteria to match the 
applicant 1 city to ‘new 
York 

!= APP1_ADDR_CITY!=’New York’ //*[APP1_ADDR_CITY!=’New York’] Criteria to match the 
applicant 1 city not equal 
to ‘new York’ 

< APP1_DOB_YEAR<’1970’ //*[APP1_DOB_YEAR<’1970’] Criteria to match applicant 
DOB less than 1970 

<= APP1_DOB_YEAR<=’1970’ //*[APP1_DOB_YEAR<=’1970’] Criteria to match applicant 
DOB less than or equal to 
1970 

> APP1_DOB_YEAR>’1970’ //*[APP1_DOB_YEAR>’1970’] Criteria to match applicant 
DOB greater than 1970 
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>= APP1_DOB_YEAR>=’1970’ //*[APP1_DOB_YEAR>=’1970’] Criteria to match applicant 
DOB greater than or equal to 
1970 

or APP1_ADDR_ZIP=’12121’ or 
APP1_ADDR_ZIP=’21212’ 

//*[APP1_ADDR_ZIP=’12121’ or 
APP1_ADDR_ZIP=’21212’] 

Criteria to match applicant 
1 zip to 12121 or 21212 

and APP1_ADDR_ZIP=’12121’ and 
APP1_DOB_YEAR<=’1970’ 

//*[APP1_ADDR_ZIP=’12121’ and 
APP1_DOB_YEAR<=’1970’] 

Criteria to match zip to 
12121 and DOB year less than 
or equal to 1970. 

substring substring(APP1_DOB_YEAR,1,3)= 
'197' 

//*[substring(APP1_DOB_YEAR,1,3)= 
'197'] 

Criteria to match applicant 
DOB from 1970 to 1980. 

Mixed 
Condition 1 

(APP1_ADDR_ZIP='07201' or 
APP1_ADDR_ZIP='07202' or 
APP1_ADDR_ZIP='07206') and 
(SNR1_FULL_NAME_FML!='' and 
SNR2_FULL_NAME_FML!='' and 
SNR3_FULL_NAME_FML!='') 

//*[(APP1_ADDR_ZIP='07201' or 
APP1_ADDR_ZIP='07202' or 
APP1_ADDR_ZIP='07206') and 
(SNR1_FULL_NAME_FML!='' and 
SNR2_FULL_NAME_FML!='' and 
SNR3_FULL_NAME_FML!='') 

Criteria to match applicant 
1 living in Elizabeth, NJ 
and the document requires 
three signers 

Mixed 
Condition 2 

(APP1_ADDR_ST='NY' or 
APP1_ADDR_ST='NJ') and 
APP1_DOB_YYYY<'1956' 

//*[(APP1_ADDR_ST='NY' or 
APP1_ADDR_ST='NJ') and 
APP1_DOB_YYYY<'1956'] 

Criteria to match applicant 
1 living in either NY or NJ 
and being at least 50 years 
old 

1 ‘//*[‘ will be added at the beginning and ‘]’ at the end automatically to make it a valid 
XPath expression. 
Notes: 
Connectors are case-sensitive. Use "or" and "and", not "OR" and "AND" 
In complex expressions, enclose similar expressions in parentheses to control the order in 
which they are handled. For example, in Mixed Condition 1, the Zip Codes will be evaluated 
first, then the signers' names, then the combination of the two. 
Please refer to http://www.w3schools.com/xpath/xpath_syntax.asp for other operators 
supported in XPath string.  
Please refer to http://www.w3schools.com/xpath/xpath_functions.asp for using various other 
functions in the XPath string. 
Add Criteria 

1 From the Criteria Maintenance page, 
Click Add Criteria. 

 

http://www.w3schools.com/xpath/xpath_syntax.asp
http://www.w3schools.com/xpath/xpath_functions.asp
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2 A new line opens. 

 
The following fields are now active. 

• Criteria Name: The name of the criteria. 
• Condition: The criteria condition can be any valid XPath expression. 
• Description: The description of the criteria. 
After completing all fields, 
Click Update to save the changes.  
The Criteria Maintenance page refreshes, displaying the new criteria. 

Edit Criteria 
From the Criteria Maintenance page, 
Click Edit to the left of the criteria you want to edit.  
The Criteria Name, Condition and Description fields are now available to edit. 
Enter any necessary changes. 
Click Update. 
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Apply Criteria to Documents 
After criteria have been defined, they must be attached to a document in order to be effective. 
From the Documents Maintenance page, click Edit next to the document to be edited. 
The Document Maintenance page refreshes with the document fields unlocked for editing. 

 
• Criteria: Select from the dropdown menu. 
The Document Maintenance page refreshes showing your selection. 
Click Update to save the changes. 
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Delete Criteria 

 
When a criterion is associated with a document and that criterion is deleted, the 
Criteria field in the Document Maintenance page resets to None. 

From the Criteria Maintenance page, 

 
 1 Check the box to the left of the criteria to be deleted. 
 2 Check the box at the top of the column to select all. 

 
Clicking Delete Selected will delete the criteria with no warning confirmation. 

 3 Click Delete Selected. 

Remote Attachment Template 

 
Remote attachment definitions must previously be created in AIM, on the Documents 
(XML) page, or the Documents (RTS) page. 

 

 
IMM eSign Remote must be activated to view this page. 

 
Remote Attachment Templates are groups of attachment definitions that can be associated with 
discrete processes (Car Loan, Home Loan, etc.)  
The Remote Attachment Template can be applied to any or all individual document signers in a 
session on the eSignature Management page. 
These attachments will be electronically supplied by the applicant during the signing experience 
on the Adobe Sign website. 
Click Administration > Remote Attachment Template. 

1 

 2 

 

3 
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 1 Search by Template Name: When editing templates, this allows quick location of existing 

templates by filtering the name. The search will automatically start after typing 2 letters. 
 2 List of existing templates 
 3 Platform: This is also referred to as a dictionary. 
 4 Attachments Icon: Click to expand and edit the attachments. 
 5 Save Icon: Click to save changes to the template. 
 6 Delete Icon: Click to delete the associated template. 
Template Attachment Details 
After clicking the Attachments icon, the template row is expanded to display the Requested 
Attachments section. 

 
 1 AIM-Defined Attachment Details: The Attachment Name and Description are defined in 

AIM and cannot be edited on this screen. 
 2 Required: When checked the attachment will be required when the session is remotely 

signed. This required checkbox can be toggled when processing the session. 
 3 Save Icon: Click to save changes to the attachment. 
 4 Delete Icon: Click to delete the associated attachment. 
 5 Select Attachment: Click to add an attachment to the template. 

1 

 

2 

 

3 

 

4 

 

5 

 

1 

 

2 

 
3 

 

4 

 

5 

 

6 
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Add Template 

1 Click in the Add Template text box to start. 

 
 1 Add Template: Enter a new template name. 
 2 Add Description: Enter a template description. 
 3 Platform: Select a platform (sometimes referred to as a dictionary). 
 4 Save: Click the Save icon. The page refreshes.  

Add Attachment 

1 After a template is added or in an existing template, add attachments to the template. 

 
 1 Select Attachment: Click to select an attachment. 

2 

 

1 

 

1 

 

3 

 
4 

 



  IMM eSign 2018.1 
  User/Document Administrator Guide  

 

Rev. 2/27/19  231 

2 

  
 1 Required: When checked the associated attachment will be required before the 

session can be sent for signatures. 
 2 Save: Click to save changes to the attachment. 
After clicking Save, the screen refreshes showing the added attachment and a new 
Select Attachment line. 

3 Repeat as necessary for additional attachments. 

Edit Template 

1 From the Remote Attachment Template Maintenance page, edit a template. 

 
 1 Click in the Template Name or Description and make changes as necessary. 
 2a Save: Click to save changes to a new template.  
 2b Save: Click to save changes to an existing template. 
 3 Attachments: Click to expand and edit the attachments. 
 4 Delete: Click to delete the associated template. A confirmation popup appears. Click OK to 

delete the template. 

1 

 

2 

 

1 

 

2b 

 

2a 

 
3 

 

4 

 



IMM eSign 2018.1  
User/Document Administrator Guide  

232 Copyright © 2019 IMM Rev. 2/27/19 

Edit Attachment 

1 After expanding the attachments, edit the Required checkbox. 

 
  1    Only the Required checkbox can be edited. 
 2 Save Icon: Click to save changes to the attachment. 
 3 Delete Icon: Click to delete the associated attachment. 

 
 

1 

 

2 

 

3 
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Contact IMM Support 
Feel free to contact us with any issues or concerns. 
 
Phone: 800.836.4750 Option 3 (8:30am - 10:30pm ET) 
Fax: 908.862.6446 
Email: support@immonline.com  
 

 
2 City Hall Plaza, 2nd Floor 
Rahway, NJ 07065 
 

mailto:support@immonline.com
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